
N5261A and N5262A  
Millimeter Head Controller

The N5261/62A Millimeter Head Controller was designed for use with the N52xx Network Analyzer family and 

banded millimeter-wave system solutions.

USER'S AND SERVICE GUIDE



Notices

© Keysight Technologies, Inc. 2011, 
2014-2016, 2019, 2020, 2023

No part of this manual may be 
reproduced in any form or by any 
means (including electronic storage 
and retrieval or translation into a 
foreign language) without prior 
agreement and written consent 
from Keysight Technologies, Inc. as 
governed by United States and 
international copyright laws.

Trademark Acknowledgments

Manual Part Number

N5262-90001

Edition

Print Date, June 2023

Supersedes: April 2023

Printed in USA

Published by:
Keysight Technologies
1400 Fountaingrove Parkway Santa 
Rosa, CA 95403

Warranty

THE MATERIAL CONTAINED IN 
THIS DOCUMENT IS PROVIDED “AS 
IS,” AND IS SUBJECT TO BEING 
CHANGED, WITHOUT NOTICE, IN 
FUTURE EDITIONS. FURTHER, TO 
THE MAXIMUM EXTENT PERMITTED 
BY APPLICABLE LAW, KEYSIGHT 
DISCLAIMS ALL WARRANTIES, 
EITHER EXPRESS OR IMPLIED WITH 
REGARD TO THIS MANUAL AND 
ANY INFORMATION CONTAINED 
HEREIN, INCLUDING BUT NOT 
LIMITED TO THE IMPLIED 
WARRANTIES OF 
MERCHANTABILITY AND FITNESS 
FOR A PARTICULAR PURPOSE. 
KEYSIGHT SHALL NOT BE LIABLE 
FOR ERRORS OR FOR INCIDENTAL 
OR CONSEQUENTIAL DAMAGES IN 
CONNECTION WITH THE 
FURNISHING, USE, OR 
PERFORMANCE OF THIS 
DOCUMENT OR ANY INFORMATION 
CONTAINED HEREIN. SHOULD 
KEYSIGHT AND THE USER HAVE A 
SEPARATE WRITTEN AGREEMENT 
WITH WARRANTY TERMS 

COVERING THE MATERIAL IN THIS 
DOCUMENT THAT CONFLICT WITH 
THESE TERMS, THE WARRANTY 
TERMS IN THE SEPARATE 
AGREEMENT WILL CONTROL.

Technology Licenses

The hardware and/or software 
described in this document are 
furnished under a license and may be 
used or copied only in accordance 
with the terms of such license.

U.S. Government Rights

The Software is “commercial 
computer software,” as defined 
by Federal Acquisition Regulation 
(“FAR”) 2.101. Pursuant to FAR 
12.212 and 27.405-3 and 
Department of Defense FAR 
Supplement (“DFARS”) 227.7202, 
the U.S. government acquires 
commercial computer software 
under the same terms by which 
the software is customarily 
provided to the public. 
Accordingly, Keysight provides 
the Software to U.S. government 
customers under its standard 
commercial license, which is 
embodied in its End User License 
Agreement (EULA), a copy of 
which can be found at 
http://www.keysight.com/find/sweula 
The license set forth in the EULA 
represents the exclusive authority 
by which the U.S. government 
may use, modify, distribute, or 
disclose the Software. The EULA 
and the license set forth therein, 
does not require or permit, 
among other things, that 
Keysight: (1) Furnish technical 
information related to 
commercial computer software 
or commercial computer 
software documentation that is 
not customarily provided to the 
public; or (2) Relinquish to, or 
otherwise provide, the  
government rights in excess of 
these rights customarily provided 
to the public to use, modify, 
reproduce, release, perform, 
display, or disclose commercial 
computer software or 
commercial computer software 

documentation. No additional 
government requirements 
beyond those set forth in the 
EULA shall apply, except to the 
extent that those terms, rights, or 
licenses are explicitly required 
from all providers of commercial 
computer software pursuant to 
the FAR and the DFARS and are 
set forth specifically in writing 
elsewhere in the EULA. Keysight 
shall be under no obligation to 
update, revise or otherwise 
modify the Software. With 
respect to any technical data as 
defined by FAR 2.101, pursuant 
to FAR 12.211 and 27.404.2 and 
DFARS 227.7102, the U.S. 
government acquires no greater 
than Limited Rights as defined in 
FAR 27.401 or DFAR 227.7103-5 
(c), as applicable in any technical 
data.

Safety Notices

A CAUTION notice denotes a hazard. It 
calls attention to an operating 
procedure, practice, or the like that, 
if not correctly performed or adhered 
to, could result in damage to the 
product or loss of important data. Do 
not proceed beyond a CAUTION 
notice until the indicated conditions 
are fully understood and met. 

A WARNING notice denotes a hazard. 
It calls attention to an operating 
procedure, practice, or the like that, 
if not correctly performed or adhered 
to, could result in personal injury or 
death. Do not proceed beyond a 
WARNING notice until the indicated 
conditions are fully understood and 
met.

A NOTE calls the user's attention to 
an important point or special 
information in the text.



Keysight N5261/62A User’s & Service Guide  

Chapter 1 - Installation and System Operation    1  

Table of Contents

Introduction    2 

Description    3

Verifying Your Shipment    3    

Test Set Accessories    4 

General Specifications    5

    General Characteristics    5

Front Panel Features     7

Rear Panel Features    9

Available Fuses    11

Network Analyzer Requirements    12 

System Configurations    13

 PNA Based Configurations    13

    PNA-X Based Configurations    14 

System Accessory Information    16

 N5261A Interface Kits    16

 N5262A Interface Kits    17

 Test Set to the Module Cable Sets    19

Compatible mm-wave Modules    20

 Available OML Modules    21

    Available VDI Modules    21

Cable Loss Between the Test Set and the Module    22

System Configuration and Operation    23

 Site Preparation    23

 System Setup    24

Rear Panel Connections    29

PNA and PNA-X Front Panel Connections    35 

Millimeter-wave Module Cable Connections    36 

Configuring the Network Analyzer Firmware    39 

System Operation Verification    42

System Level Troubleshooting    47   



Keysight N5261/62A User’s & Service Guide  

2 Service Information    49

Part Replacement and Location Information 50

    Replaceable Parts    50

Test Set Diagrams and Graphics    51 

Theory of Operation    60

    Functional Block and Assembly Information    60 

Troubleshooting the Test Set    63

    Troubleshooting, DC Level    63

   Power Supply and Fans    63

       Overcurrent LEDs are ON (Amber)    65         

   Front Panel Active and Port Status LED    65

    Troubleshooting, RF Level    67

RF Out Failures    67

        LO Out Failure    67

        REF IF or Test IF Failure    68
    Test Set Operation Check    68

     Preparation    68

        Required Equipment    68

        Power Sensor and Power Meter Preparation    69

        PNA Test Set Preparation    69

        PNA Normalization Calibration    69

        Test Set I/O Commands    70

        Controlling the Test Set Using Test Set I/O Commands    70         

Using the GPIB Command Processor    70

        Test Set I/O Command List    71

Test and Adjustment Procedures    78

Gain Factors in the SRC RF Paths    79

       Adjust ALC Levels    83 

Safety and Information    85

Introduction    85     

Safety Earth Ground    85



Keysight N5261/62A User’s & Service Guide  

2 Service Information

    claration of Conformity    85

 Statement of Compliance    85

 Before Applying Power    86

       Connector Care and Cleaning Precautions    87

Regulatory Information    89

    Instrument Markings    89  

    Battery Collection    90  

    Electrical Safety Compliance    90 

 EMI and EMC Compliance    90  

 Electrical Discharge Protection    91

 Keysight Support, Services, and Assistance    92

 Contacting Keysight    92

 Shipping Your Product to Keysight for Service or Repair    92



Keysight N5261/62A User’s & Service Guide 1

Installation & System Operation



2   Keysight N5261/62A User’s & Service Guide

Introduction

Figure 1-1 

Installation & System Operation 

This section of this document describes system installation and operation of 
the N5261A/N5262A Millimeter Module Controller. 

Note: This document contains references to Agilent. Please note that 
Agilent’s Test and Measurement business has become Keysight Technologies. 
For more information, go to www.keysight.com.

2-Port Banded Millimeter-wave Configuration (N5261A)

Figure 1-2 4-Port Banded Millimeter-wave Configuration (N5262A)
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Description

Installation & System Operation 

The N5261/62A Millimeter Head Controller was designed for use with the 
N52xx Network Analyzer family and banded millimeter-wave system solutions. 
Banded millimeter-wave systems are made up of three types of major 
components: a PNA or PNA-X, a controller test set, and millimeter-wave 
heads. These components are generally purchased separately and assembled 
into a system at the customer's site. 

Table 1-4 on page 13 and Table 1-5 on page 14 lists compatible PNA and 
PNA-X models with required options. Table 1-9 on page 21 and Table 1-10 on 
page 21 list available millimeter-wave modules. Typical system configurations 
are pictured in Figure 1-1 on page 2 and Figure 1-2 on page 2.

The N5261A or N5262A Millimeter Head Controller may also be used as part of 
the N5251A broadband analyzer system. This application is not discussed in 
this manual. Refer to N5251-90001 for N5251A system information.

In this document the N5261A and N5262A will be referred to as the test set.

This manual should be used in conjunction with the following documents:

— PNA-X Series Network Analyzer On-line Help System 

— OML Millimeter Wave Modules (N5256-90001)

— VDI Millimeter Wave Modules (N5256-90002)

— Banded Millimeter Wave Network Analysis - Technical Overview
     (5992-2177)

Verifying Your Shipment
To verify the contents shipped with your product, refer to the “Box Content 
List” included with the shipment. For a list of option components, refer to Table 
1-6 on page 16.

Inspect the shipping container. If the container or packing material is 
damaged, it should be kept until the contents of the shipment have been 
checked mechanically and electrically. If there is physical damage refer to 
“Contacting Keysight” on page 92. Keep the damaged shipping materials (if 
any) for inspection by the carrier and a Keysight Technologies representative. 

The N5261/62A Millimeter Head Controller and the millimeter-wave modules 
are sensitive to electrostatic discharge (ESD). Ground your work station 
before unpacking and installing the millimeter-wave modules. See 
“Electrostatic Discharge Protection” on page 91.

http://na.support.keysight.com/pna/help/
https://www.keysight.com/us/en/assets/7018-05658/technical-overviews/5992-2177.pdf
https://literature.cdn.keysight.com/litweb/pdf/N5256-90001.pdf?id=1721945
https://literature.cdn.keysight.com/litweb/pdf/N5256-90002.pdf?id=2387439
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Test Set Accessories

Use the tables below to verify that your shipment is complete. 

Table 1-1 N5261/62A Standard Content 

√ Keysight 
Part Number

Ref Des Description Qty

N5261A or 
N5262A 

Millimeter Head Controller Test Set 1

1810-0118 
(N5261A)

Coax Termination, 50 Ohm, male (load) 1

1810-0118 
(N5262A)

Coax Termination, 50 Ohm, male (load) 2

N4011-21002 W7 Multi-Cond Flex CA AY - DSub25 m/m, 520mm 
(20in), Rear Panel Connections

1

9230-0333 Envelope (Calibration Certificate) 1

9320-6636 Functional Certificate 1

N5262-90001 User’s and Service Guide 1

N5256-90001 OML Module Product Note 1

N5256-90002 VDI Module Product Note 1

Table 1-2 N5261/62A Front Handle Kit Options 

√
Keysight 
Part Number

Description Qty

Option 1CM (Rackmount Kit without Front Handles)

5063-9215 Rackmount Kit - 177.OH-without Handle 1

Option 1CN (Front Handle Kit)

5063-9228 Front Handle Kit - 177.OH 1

Option 1CP (Rackmount Kit with Front Handle Kit)

5063-9222 Rackmount Kit with handle- 177.OH 1
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General Specifications

Specifications for the test set are characteristic of the test set. A 
functional certificate is only offered for the test set.  A periodic 
calibration of the test set is not required.

General Characteristics

This product is designed for use in Installation Category II and Pollution 
Degree 2.

Required Conditions for Accuracy Enhanced Measurement
Accuracy-enhanced (error-corrected) measurements require the ambient temperature of the 
N5261/62A to be maintained within ± 1 °C of the ambient temperature at calibration.

The instrument can safely operate in a relative humidity of 80% for temperatures to 31 degrees 
C, decreasing linearly to 50% relative humidity at 40 degrees C.

Ventilation Requirements: When installing the instrument in a cabinet, the 
convection into and out of the instrument must not be restricted. The ambient 
temperature (outside the cabinet) must be less than the maximum operating 
temperature of the instrument by 4 °C for every 100 watts dissipated in the 
cabinet. If the total power dissipated in the cabinet is greater than 800 watts, 
forced convection must be used.

Environmental:

Temperature 20 to 30 °C

Altitude 3,000 meters (9,842 ft)

Power Requirements:

Nominal Frequency Range

Nominal Voltage Range

N5261A or N5262A Power

50/60 Hz

100/120/220/240 Vac 

350 Watts (Max.)

Weight and Dimensions:

Net Weight N5261A 10 kg (22 lb)
N5262A 11 kg (24.2 lb)

Dimensions Height: 18 cm (7.1 in)   
Width: 42.5 cm (16.75 in)
Depth: 42.5 cm (16.75 in)
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Table 1-3 Characteristics and Specifications 

Front/Rear Panel Connector1 Power Levels (dBm) Gain Frequency 

Min Typ Max2

N5261A 

TEST or REF IF (Input) (characteristic) − −27 −10 − 7.6 MHz

TEST IF to A/B/C/D IF OUTPUT (specification) 
See Figure 2-17 on page 77.

− − − −1.5 dB (± 1) 7.6 MHz

REF IF to A/B/C/D IF OUTPUTS (specification) 
See Figure 2-17 on page 77.

− − − −1.5 dB (± 1) 7.6 MHz

REF IF to R IF OUTPUTS (specification) 
See Figure 2-17 on page 77.

− − −1.5 dB (± 1) 7.6 MHz

LO IN (characteristic) −10 − 2 − 8 to 19 GHz

LO OUT (specification)3 
See Figure 2-14 on page 72.

10 11.5 14.5 >14.5 dB 8 to 19 GHz

SRC1 RF IN (characteristic) 0 − 15 − 8 to 19 GHz

RF OUT (specification)4
See Figure 2-15 on page 74.

10 11.5 14.5 >14.5 dB 8 to 19 GHz

N5262A 

TEST or REF IF (Input) (characteristic) − −27 −10 − 7.6 MHz

Test IF to A/B/C/D IF OUTPUTS (specification) 
See Figure 2-17 on page 77.

− − −2 dB (± 1) 7.6 MHz

Ref IF to A/B/C/D IF OUTPUTS (specification) 
See Figure 2-18 on page 77.

− − −4 dB (± 1.5) 7.6 MHz

Ref IF to R IF OUTPUTS (specification) 
See Figure 2-19 on page 77.

− − −5 dB (± 1.5) 7.6 MHz

LO IN (characteristic) −10 − 2 − 8 to 19 GHz

LO OUT (specification)3

See Figure 2-14 on page 72.
10 11.5 14.5 14.5 dB 8 to 19 GHz

SRC1 or SRC2 RF IN (characteristic) 0 − 15 − 8 to 19 GHz

RF OUT (specification)4

See Figure 2-15 on page 74.
10 11.5 14.5 14.5 dB 8 to 19 GHz

1. All connectors are SMA female.
2. Do not exceed the maximum level or damage may occur.
3. With a −3 dBm Input, measure on the test set connector. See Figure 2-14 on page 72.
4. ALC on and with 0 dBm Input, measure on the test set connector. See Figure 2-15 on page 74.
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Front Panel Features

Figure 1-3 N5261A (2-Port) Front Panel Features

Figure 1-4 N5262A (4-Port) Front Panel Features

LO Out  SRC1 Input   Port Status LEDs

RF Out

Ref IF

Test IF

Standby Switch      Over Current LEDs DC Power

  
  
Active
LED

Active
LED

SRC1 and SRC2 Inputs Port Status LEDsLO Out

Ref IF
RF Out

Test IF

 Standby Switch Over Current LEDs   DC Power
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TEST IF

IF signal input connection from the millimeter module’s Test or Measure IF 
Output. 

REF IF

Reference IF signal input connection from the millimeter module’s Reference IF 
Output.

RF OUT

Provides an amplified RF source signal to the millimeter-wave module’s RF 
Input.

LO OUT

Provides amplified LO signal to the millimeter-wave module’s LO Input.

SRC1 and SRC2 

Connects to the analyzer’s front panel Test Ports for RF Output power.

Port Status LEDs

The amber LEDs indicate which source port is active. The green LEDs indicate 
which receiver port is active. All receivers are active in normal operation.

DC Power (Bias)

This bias supplies the +12 Vdc and ground lines for OML millimeter-wave 
modules. Pins 1 and 3 are both +12 Vdc supplies. Pins 4 and 6 are the dc 
supply ground lines. Pins 2, 5, and 7 are unused. The DC power connections 
are intended for use with OML modules.

DC Power/Overcurrent LEDs
The green LEDs indicate that the DC power bias is on. The amber 

LEDs indicate an overcurrent condition.

Standby Switch

The switch is only a Standby switch, not a AC line power switch. 

Active LED

When the test set is connected and addressed by a analyzer, the LED is On 
(illuminated). The LED is Off (not illuminated) when the test set is in Standby, 
or not addressed by the analyzer.

The SRC2 Input and Ports 3 and 4 features are not present on the N5261A. 
Refer to Figure 1-1 on page 2.
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Rear Panel Features

Figure 1-5 N5261A Rear Panel Features

Figure 1-6 N5262A Rear Panel Features 

 Line Module   Test Set I/O    Pass Thru Interface Chassis Ground  

IF Outputs D, C, B, A LO IN SRC1 IN/OUT

R

IF Outputs  LO IN SRC2 IN/OUTSRC1 IN/OUT 

Line Module   Test Set I/O    Pass Thru Interface Chassis Ground 
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IF OUTPUTs – SMA (female)

— D (from the test set to the analyzer’s IF D Input)

— C (from the test set to the analyzer’s IF C Input)

— R (from the test set to the analyzer’s IF R Input, not installed in the N5261A)

— A (from the test set to the analyzer’s IF A Input)

— B (from the test set to the analyzer’s IF B Input)

LO IN

This input is from the LO drive of the analyzer. The signal is split and amplified 
and then output to the front panel of the N5261/62A.

SRC 1 RF IN and SRC 1 RF OUT

Test set rear panel RF Input access for use with the analyzer’s Option 224 or 
423. 
SRC 1 provides the power input for RF OUT Ports 1 & 2.

SRC 2 RF IN and SRC 2 RF OUT (Not installed in the N5261A)

Rear panel RF Input access for use with the analyzer’s Option 224 or 423. 
SRC 2 provides the power input for RF OUT Ports 3 & 4. 

Chassis Ground

A threaded terminal post for connecting the test set to a conductive object, 
cabinet or structure to ensure a common potential and reduce leakage current 
in a system. Requires an English 1/4-20 thread nut (0140-0084) and lock 
washer (2190-0067).   

Pass Through Interface

Connection to another test set.

Test Set I/O

The test set interface connector is used to send address and data to the test 
set from the analyzer.

Line Module

This assembly houses the line cord connection, line fuse, and line voltage 
selector. Remove the line module cover to replace or change the fuse. Line 
voltage selection is automatic and no setting is required. Recommended fuse 
values are printed on the rear panel of the N5261/62A.
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Power Cords

A line power cord is supplied in one of several configurations, depending on 
the destination of the original shipment. Keysight can supply additional 
certified power cords to meet region electrical supply and receptacle 
configurations. Please refer to our website at: http://www.keysight.com for 
assistance in power cord selection. 

Available Fuses

—  Fuse (F 5 A/250V, 2110-0709) UL listed and CSA certified.

For continued protection against fire hazard replace line fuse only with same 
type and rating. The use of other fuses or material is prohibited.

Figure 1-7 Line Fuse 

Verify that the premise electrical voltage supply is within the range specified 
on the instrument.
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Network Analyzer Requirements
The required options for PNA models are indicated in the “PNA Option(s)” 
column of Table 1-4. The required options for PNA-X models are indicated in 
the “PNA Option(s)” column of Table 1-5. Note that all models require Option 
020.

The minimum firmware revision for PNA "A" models is A.09.42.16. 

The minimum firmware revision for PNA-X "A" models is A.09.33.09.

There is no minimum firmware revision for PNA or PNA-X "B" models. 
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System Configurations
Table 1-4 and Table 1-5 document all supported configurations for 
S-Parameter measurement capabilities for banded mm-wave systems using
the N5261A and N5262A test sets.

Capabilities: [C1]=pulse, [C2]=power control/RCVR leveling, 
[C3]=SMC+phase, [C4]=SPM, [C5]=ITSMA

Table 1-4 PNA Based Configurations 

PNA Model 
(s)

PNA 
Options1

Test Set SRC 
Connects

Ck2 Cable Interface 
Kit

Cable 
Config. 
Diag(s)3

Capabilities and 
Notes

N5222A/B 200, 201 or 
219

N5261A front n N5261A-102 A Y [C1,C2,C3,C4__]

N5262A front n N5262A-102 B V [C1,C2__C4,__]4 

400, 401 or 
419

N5261A front n N5261A-104 A Z [C1,C2,C3,C4__]

N5262A front n N5262A-104 B X [C1,C2,C3,C4,C5]

N5224A/B
N5225A/B

200, 201 or 
219

N5261A front n N5261A-112 A Y [C1,C2,C3,C4__]

N5262A front n N5262A-112 B V [C1,C2__C4,__]4

400, 401 or 
419

N5261A front n N5261A-114 A Z [C1,C2,C3,C4__]

N5262A front n N5262A-114 B X [C1,C2,C3,C4,C5]

N5227A/B 200, 201 or 
219

N5261A front n N5261A-112 A Y [C1,C2,C3,C4__]

rear y N5261A-112 E [C1,C2,C3,C4__]

N5262A front n N5262A-112 B V [C1,C2__C4,__]4

rear xxxxxx xxx config not available

400, 401 or 
419

N5261A front n N5261A-114 A Z [C1,C2,C3,C4__]

rear y N5261A-114 E [C1,C2,C3,C4__]

N5262A front n N5262A-114 B X [C1,C2,C3,C4,C5]

rear y N5262A-114 F [C1,C2,C3,C4,C5]

5

1. All PNAs require Option 020. When a 2 port VNA (option 200) is used with a 4 port controller (N562A) the PNA will need the N-port 
measurements option. 

a. For A models, Option 551 N-Port Calibrated Measurements. 

b. For B models, Option S93551B N-Port Calibrated Measurements.

2. Condition of the Route PNA RF to rear panel “RF OUT” check box. n = not checked, y = check. Refer to step 9 on page 41.

3. See Rear Panel Figures 1-15 to 1-20 (A-F) and Front Panel Figures 1-21 to 1-22 (V-Z) for the configuration diagrams.

4. Can only drive output on one port at a time in this configuration.

5. See Table 1-6 and Table 1-7 for Interface Cable Kits.  
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Table 1-5 PNA-X Based Configurations 

PNA-X 
Model (s)

PNA
Option(s)1 

Test Set SRC 
Connects

Ck2 Cable Interface 
Kit

Cable 
Config.

Diag(s)3

Capabilities and 
Notes

N5242A/B 200 N5261A front n N5261A-102 A Y [C1,C2,C3,C4__]

N5262A front n N5262A-102 B V [C1,C2__C4,__]4

200 & 224 N5261A front n N5261A-102 A Y [C1,C2,C3,C4__]

rear y N5261A-102 C [C1,C2,C3,C4,__]

N5262A front n N5262A-102 B W [C1,C2,C3,C4,__]

rear y N5262A-104 D [C1,C2,C3,C4,__]

400 N5261A front n N5261A-104 A Z [C1,C2,C3,C4__]

N5262A front n N5262A-104 B X [C1,C2,C3,C4,C5]

400 & 423 N5261A front n N5261A-104 A Z [C1,C2,C3,C4__]

rear y N5261A-104 C [C1,C2,C3,C4,__]

N5262A front n N5262A-104 B X [C1,C2,C3,C4,C5]

rear y N5262A-104 D [C1,C2,C3,C4,C5]

N5244A/B
N5245A/B

200 N5261A front n N5261A-112 A Y [C1,C2,C3,C4__]

N5262A front n N5262A-112 B V [C1,C2__C4,__]4

200 & 224 N5261A front n N5261A-112 A  Y [C1,C2,C3,C4__]

rear y N5261A-106 C [C1,C2,C3,C4__]

N5262A front n N5262A-112 B W [C1,C2,C3,C4__]

rear y N5262A-108 D [C1,C2,C3,C4__]

400 N5261A front n N5261A-114 A Z [C1,C2,C3,C4__]

N5262A front n N5262A-114 B X [C1,C2,C3,C4,C5]

400 & 423 N5261A front n N5261A-114 A Z [C1,C2,C3,C4__]

rear y N5261A-108 C [C1,C2,C3,C4,__]

N5262A front n N5262A-114 B X [C1,C2,C3,C4,C5]

rear y N5262A-108 D [C1,C2,C3,C4,C5]

(Continued on page 15)
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PNA-X 
Model (s)

PNA 
Option(s)1

Test Set SRC 
Connects

Ck2 Cable Interface 
Kit

Conn. 
Diag(s)3

Capabilities and 
Notes

N5247A/B 200 N5261A front n N5261A-112 A Y [C1,C2,C3,C4__]

rear y N5261A-102 E [C1,C2,C3,C4__]5

N5262A front n N5262A-112 B V [C1,C2,C3,C4__]4

rear xxxx xxxx config not available

200 & 224 N5261A front n N5261A-112 A Y [C1,C2,C3,C4__]

rear y N5261A-102 E [C1,C2,C3,C4,__]6

N5262A front n N5262A-112 B W [C1,C2,C3,C4__]

rear y N5262A-104 F [C1,C2,C3,C4,__]

400 N5261A front n N5261A-114 A Z [C1,C2,C3,C4__]

rear y N5261A-102 E [C1,C2,C3,C4,__]7

N5262A front n N5262A-114 B X [C1,C2,C3,C4,C5]

rear y N5262A-104 F [C1,C2,C3,C4,C5]

400 & 423 N5261A front n N5261A-114 A Z [C1,C2,C3,C4__]

rear y N5261A-104 E [C1,C2,C3,C4,__]6

N5262A front n N5262A-114 B X [C1,C2,C3,C4,C5]

rear y N5262A-104 F [C1,C2,C3,C4,C5]8

Table 1-5 PNA-X Based Configurations (Continued) 

1. All PNAs require Option 020. When a 2 port VNA (option 2xx) is used with a 4 port controller (N562A) the PNA will need the N-port 
measurements option. 

a. For A models, Option 551 N-Port Calibrated Measurements. 

b. For B models, Option S93551B N-Port Calibrated Measurements.

2. Condition of the Route PNA RF to rear panel “RF OUT” check box. n = no, y = check, x = don’t care. Refer to step 9 on page 41.

3. See Rear Panel Figures 1-15 to 1-20 (A-F) and Front Panel Figures 1-21 to 1-22 (V-Z) for the configuration diagrams.

4. Can only drive output on one port at a time in this configuration.

5. Must use RF OUT on the rear panel.

6. Must use RF OUT or RF1 OUT on the rear panel. Options 224 and 423 do not provide rear panel connections for Port 1. Functionality 
is the same as PNA-X without Option 224/423.

7. Must use RF1 OUT on the rear panel.

8. Must use RF OUT or RF2 OUT on the rear panel. Functionality is the same as PNA-X without Option 224/423. 
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System Accessory Information

Table 1-6 

The following tables provide information on available measurement 

system interface options.

N5261A to the Module Cable Set Options (Sold Separately) 

√
Keysight 
Part Number

Ref Des Description Qty

N5261A Option 102 (Interface Kit for 2-Port PNA N5222/42A/B)

5061-9038 Coax Flex CA-Assy - SMA (m/m), 
520 mm (20 in), rear panel connections

6

N5262-20016 W1 Coax Rigid CA-Assy, SMA (m/f), (SRC1 to Port 1 PNA) 1

U3021-60002 Lock Link Kit, Test Set to PNA-X 1

N5261A Option 104 (Interface Kit for the 4-Port PNA N5222/42A/B)

5061-9038 Coax Flex CA-Assy - SMA (m/m), 
520 mm (20 in), rear panel connections

6

N5262-20018 W1 Coax Rigid CA-Assy, SMA (m/f), (SRC1 to Port 1 PNA) 1

U3021-60002 Lock Link Kit, Test Set to PNA 1

N5261A Option 106 (Interface Kit for the 2-Port PNA N5224/25/44/45A/B)

5061-9038 Coax Flex CA-Assy - SMA (m/m), 
520 mm (20 in), rear panel connections

6

N5262-20023 W1 Coax Rigid CA-Assy, SMA male to 2.4 mm female 
(SRC1 to Port 1 PNA)

1

N4903-61250 Coax Adapter (3.5 mm female to 2.4 mm male) 1

U3021-60003 Lock Link Kit, Test Set to PNA 1

N5261A Option 108 (Interface Kit for the 4-Port PNA N5224/25/44/45A/B)

5061-9038 Coax Flex CA-Assy - SMA (m/m), 
520 mm (20 in), rear panel connections

6

N5262-20026 W1 Coax Rigid CA-Assy, SMA male to 2.4 mm female 
(SRC1 to Port 1 PNA)

1

N4903-61250 Coax Adapter (3.5 mm female to 2.4 mm male) 1

U3021-60003 Lock Link Kit, Test Set to PNA 1

N5261A Option 112 (Interface Kit for the 2-Port N5227/47A/B)

5061-9038 Coax Flex CA-Assy - SMA (m/m), 
520 mm (20 in), rear panel connections

7

N5262-20023 W1 Coax Rigid CA-Assy, SMA male to 2.4 mm female 
(SRC1 to Port 1 PNA)

1
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U3021-60003 Lock Link Kit, Test Set to PNA 1

N5261A Option 114 (Interface Kit for the 4-Port N5227/47A/B)

5061-9038 Coax Flex CA-Assy - SMA (m/m), 
520 mm (20 in), rear panel connections

8

N5262-20026 W1 Coax Rigid CA-Assy, SMA male to 2.4 mm female 
(SRC1 to Port 1 PNA)

1

U3021-60003 Lock Link Kit, Test Set to PNA 1

Table 1-7 N5262A to the Module Cable Set Options (Sold Separately)

√ Keysight 
Part Number

Ref Des Description Qty

N5262A Option 102 (Interface Kit for the 2-Port N5222/42A/B)

5061-9038 Coax Flex CA-Assy - SMA (m/m), 520 mm (20 in), rear panel 
connections

7

N5262-20016 W1 Coax Rigid CA-Assy, SMA male to female (SRC1 to Port 1 
PNA)

1

N5262-20017 W3 Coax Rigid CA-Assy, SMA male to female (SRC2 to PNA 
SRC2 (Out1))

1

N5262-20020 W2 Coax Rigid CA-Assy, SMA male to female (SRC2 to Port 2 
PNA)

1

U3021-60002 Lock Link Kit, Test Set to PNA 1

N5262A Option 104 (Interface Kit for the 4-Port N5222/42A/B)

5061-9038 Coax Flex CA-Assy - SMA (m/m), 
520 mm (20 in), rear panel connections

8

N5262-20018 W1 Coax Rigid CA-Assy, SMA male to female (SRC1 to Port 1 
PNA)

1

N5262-20019 W2 Coax Rigid CA-Assy, SMA male to female (SRC2 to Port 3 
PNA)

1

U3021-60002 Lock Link Kit, Test Set to PNA 1

N5262A Option 106 (Interface Kit for the 2-Port N5224/25/44/45A/B) 

5061-9038 Coax Flex CA-Assy - SMA (m/m), 
520 mm (20 in), rear panel connections

7

N5262-20023 W1 Coax Rigid CA-Assy, SMA male to 2.4 mm female 
(SRC1 to Port 1 PNA)

1

N5262-20024 Coax Rigid CA-Assy, SMA male to 2.4 mm female 
(SRC2 to PNA SRC2 (Out1))

1

Table 1-6 N5261A to the Module Cable Set Options (Continued) 

1

W31
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N5262-20025 W2 Coax Rigid CA-Assy, SMA male to 2.4 mm female 
(SRC2 to Port 2 PNA)

1

N4903-61250 Coax Adapter (3.5 mm female to 2.4 mm male) 2

U3021-60003 Lock Link Kit, Test Set to PNA 1

N5262A Option 108 (Interface Kit for the 4-Port N5224/25/44/45A/B)

5061-9038 Coax Flex CA-Assy - SMA (m/m), 
520 mm (20 in), rear panel connections

8

N5262-20026 W1 Coax Rigid CA-Assy, SMA male to 2.4 mm female 
(SRC1 to Port 1 PNA)

1

N5262-20027 W2 Coax Rigid CA-Assy, SMA male to 2.4 mm female 
(SRC2 to Port 3 PNA)

1

N4903-61250 Coax Adapter (3.5 mm female to 2.4 mm male) 2

U3021-60003 Lock Link Kit, Test Set to PNA 1

N5262A Option 112 (Interface Kit for the 2-Port N5227/47A/B)

5061-9038 Coax Flex CA-Assy - SMA (m/m), 
520 mm (20 in), rear panel connections

7

N5262-20023 W1 Coax Rigid CA-Assy, SMA male to 2.4 mm female 
(SRC1 to Port 1 PNA)

1

N5262-20024 Coax Rigid CA-Assy, SMA male to 2.4 mm female 
(SRC2 to PNA SRC2 (Out1))

1

N5262-20025 W2 Coax Rigid CA-Assy, SMA male to 2.4 mm female 
(SRC2 to Port 2 PNA)

1

U3021-60003 Lock Link Kit, Test Set to PNA 1

N5262A Option 114 (Interface Kit for the 4-Port N5227/47A/B)

5061-9038 Coax Flex CA-Assy - SMA (m/m), 
520 mm (20 in), rear panel connections

8

N5262-20026 W1 Coax Rigid CA-Assy, SMA male to 2.4 mm female 
(SRC1 to Port 1 PNA)

1

N5262-20027 W2 Coax Rigid CA-Assy, SMA male to 2.4 mm female 
(SRC2 to Port 3 PNA)

1

U3021-60003 Lock Link Kit, Test Set to PNA 1

Table 1-7 N5262A to the Module Cable Set Options (Continued) 

W31

1. The W3 cable is provided for the analyzer with Option 225 (2nd source front panel feature).
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Table 1-8 Test Set to the Module Cable Set Options (Sold Separately) 

√
Keysight 
Part Number

Description Qty

N5261/62A Option 501 (1-Port Trans/Refl Cable Set (48 inches = 1.2 meter))

1250-2604 Coax Connector Adapter, right angle- SMA m/f 2

8121-1221 Coax flex CA-Assy, 3.5 mm male to male, 1.2 m (48 in) - RF & LO 2

85105-60030 Multi-Cond Flex CA-Assy, Cir 7C, 1.2 m (48 in) - DC Power Bias 1

85105-60048 Coax flex CA-Assy, right angle- SMA m/m 1.2 m (48 in) - Ref & Test IF 2

N5261-60019 Cable Sleeve and Marker Kit, 1.2 m (48 in) 1

N5261/62A Option 502 (1-Port Trans/Refl Cable Set (79 inches = 2 meter))

1250-2604 Coax Connector Adapter, right angle- SMA m/f 2

N5260-60023 Coax flex CA-Assy, 3.5 mm male to male, 2 m (79 in) - RF & LO 2

N5260-60070 Coax flex CA-Assy, right angle SMA m/m, 2 m (79 in) - Ref & Test IF 2

N5260-60025 Multi-Cond Flex CA-Assy, Cir 7C, 2 m (79 in) - DC Power Bias 1

N5261-60020 Cable Sleeve and Marker Kit, 5 m (197 in) 1

N5261/62A Option 503 (1-Port Trans/Refl Cable Set (118 inches = 3 meter))

1250-2604 Coax Connector Adapter, right angle- SMA m/f 2

N5260-60026 Coax flex CA-Assy, 3.5 mm male to male, 3 m (118 in) - RF & LO 2

N5260-60027 Coax flex CA-Assy, right angle SMA m/m, 3 m (118 in) - Ref & Test IF 2

N5260-60028 Multi-Cond Flex CA-Assy, Cir 7C, 3 m (118 in) - DC Power Bias 1

N5261-60020 Cable Sleeve and Marker Kit, 5 m (197 in) 1

N5261/62A Option 505 (1-Port Trans/Refl Cable Set (197 inches = 5 meter))

1250-2604 Coax Connector Adapter, right angle- SMA m/f 2

N5260-60029 Coax flex CA-Assy, 3.5 mm male to male, 5 m (179 in) - RF & LO 2

N5260-60071 Coax flex CA-Assy, right angle SMA m/m, 5 m (179 in) - Ref & Test IF 2

N5260-60072 Multi-Cond Flex CA-Assy, Cir 7C, 5 m (197 in) - DC Power Bias 1

N5261-60020 Cable Sleeve and Marker Kit, 5 m (197 in) 1
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Compatible mm-wave Modules
Keysight offers millimeter modules manufactured by Olsen Microwave Labs 
(OML) and Virginia Diodes Inc (VDI) for use with the N5261/62A for banded 
mm-wave network analyzer systems. Refer to Table 1-9 on page 21 and
Table 1-10 on page 21.

Transmission/Reflection millimeter-wave modules contain an RF source 
multiplier, dual directional coupler, reference downconverter and a test 
downconverter. The Transmission/Reflection millimeter-wave module is 
usually the primary module of a millimeter-wave VNA system. A single 
Transmission/Reflection module allows the measurement of S11 reflection 
coefficient only. Refer to Figure 1-8.

“Receive only” millimeter-wave modules contain a test downconverter to 
receive the test signal from a Transmission/Reflection millimeter-wave module. 
The use of a Receiver module, as the second module, allows the system 
capability to measure S11 and S21 only.

The use of two Transmission/Reflection modules in the millimeter-wave VNA 
system allows for all four S-parameters to be measured. The test 
downconverters of Transmission/Reflection modules are the receivers for the 
signal from the modules sources. When the two modules waveguide are 
connected, S11 and S21 are measured in the forward direction, S22 and S12 
are measured when the signal path is reversed. If a 4-Port system is configured 
with Transmission/Reflection modules, all 16 S-parameter measurements can 
be made on a 4-Port device.

Figure 1-8 Module Configurations

S22

TxRx DUT

S11

TxRx TxRxDUT

S11

S21

S12

TxRx RxDUT

S11

S21

Full 2-Port 
Measurements

Thru Reflection 
Measurements

Reflection
Measurements
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Table 1-9 Available OML Modules1,2

Banded Freq 
Ranges (GHz)

Port Type Source Receiver Model # Notes

33 to 500 Waveguide √ √ N5256AWxx T/R Module

33 to 500 Waveguide √ N5257ARxx Receiver

33 to 500 Waveguide Dual N5258ADxx Receiver-Dual

1. The Interface Cable Set is not supplied, refer to Table 1-6 on page 16.
2. Adjustable RF Attenuator, RF & LO internal amplifiers options are available. Refer to OML millimeter-wave modules 

documentation (N5256-90001).

Table 1-10 Available VDI Modules1,2 

Banded Freq 
Ranges (GHz)

Port Type Source Receiver Model # Notes

750 to 1100 Waveguide √ √ N5262AW01-TST T/R Module

500 to 750 Waveguide √ √ N5256AW01-TST T/R Module

50 to 500 Waveguide √ √ N5262AWxx-TST T/R Module

750 to 1100 Waveguide √ N5262AR01-TST Receiver

500 to 750 Waveguide √ N5256AR01-TST Receiver

50 to 500 Waveguide √ N5262ARxx-TST Receiver

1. The Interface cable set is supplied with each VDI module. Do not order cable Options 501, 502, 503 and 505.
2. These modules are compatible with the test set only. They are provided with their own power supply, do not connect to the 

test set DC power port. Refer to VDI millimeter-wave modules documentation (N5256-90002). 
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Cable Loss Between the Test Set and the Module
If the cables between the test set and the millimeter-wave modules are longer 
than four feet, cable loss for the RF and LO paths may be excessive. Perform 
the analysis recommended below. 

Determine the input power level requirements for the millimeter-wave module 
selected for use. Refer to the documentation included with your module. To 
determine the power available at the module, calculate the cable loss using 
Figure 1-9 or Table 1-11, then subtract the cable loss from the RF and LO Out 
characteristic power of 10 dBm. You may also use a power meter. 

A separate DC supply is recommended for OML modules if they are greater than 5 meters from 
the controller. A DC bias power cable, with banana plug connectors, is available for use with a 
separate power supply such as E3615A for OML modules. VDI modules have a DC power supply 
included with the module.

If you are installing an external amplifier in the LO or RF path, ensure the amplifier’s input is 
connected to the test set, and the output is connected to the mm-wave module’s LO or RF Input. 
Modules with internal amplifiers are available. 

Figure 1-9 Typical RF Cable Loss (dB loss per foot)

Table 1-11 Typical Cable Insertion Loss (N5261/62A Options) 

Cable Option Cable Length 7 GHz 10 GHz 18 GHz

501 4 ft. (1.22 m) 1 dB 1.2 dB 1.6 dB

502 6.58 ft. (2 m) 1.65 dB 2 dB 2.65 dB

503 9.83 ft. (3 m) 2.5 dB 3 dB 4 dB

505 16.4 ft. (5 m) 4.1 dB 5 dB 6.6 dB
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System Configuration and Operation

Site Preparation

Install the instrument so that the detachable power cord is readily identifiable 
and is easily reached by the operator. An externally installed switch or circuit 
breaker (which is readily identifiable and is easily reached by the operator) 
should be used as the disconnecting device.The detachable power cord can 
also be used to disconnect the mains circuits from the mains supply before 
other parts of the instrument. The front panel switch is only a standby switch 
and is not a LINE switch. 

Protect Against Electrostatic Discharge (ESD)

IMPORTANT - If not properly protected, electrostatic discharge can seriously 
damage your analyzer, resulting in costly repair.

To reduce the chance of electrostatic discharge, follow all of the 
recommendations outlined in “Electrostatic Discharge Protection” 
on page 91.

Table 1-12  Power Requirements of a Standard Configuration

Standard Equipment

Instrument Maximum Watt 

N5222A/B, N5224A/B, N5225A/B or N5227A/B 450

N5242A/B, N5244A/B, N5245A/B or N5247A/B 450

N5261/62A Millimeter Head Controller 350

Millimeter-wave Module (OML) (powered from controller)

Millimeter-wave Module (VDI) 175
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System Setup

It is recommended that you connect the cables to the rear panel of the test set 
before mounting the analyzer on top of the test set. When the analyzer is 
mounted on the test set, the back of the analyzer extends over the rear panel 
of the test set and may interfere with access to the rear panel connectors. The 
cables can then be connected to the analyzer after it is mounted on the test 
set. Table 1-4 on page 13 or Table 1-5 on page 14 indicates which connection 
diagrams to use for your configuration. 

The network analyzer is heavy. It is recommended that two individuals, 
or a mechanical lift be used to lift or transport the instrument.

Mounting a Network Analyzer on the Test Set 

Refer to the following kits for your specific analyzer. In this procedure a 
N5242A/B 4-Port PNA-X is used with a N5262A. There are other kits available 
via the U3021M model. Refer to “Keysight Support, Services, and 
Assistance” on page 92 for ordering information.

— Locking Kit (U3021-60002) for the test set. Includes the Locking kit 
(5023-0132) and screws (0515-2317) to connect the test set to the 
N5222A/B PNA or N5242A/B PNA-X. The N5242-20138 is the right foot 
and N5242-20139 is the left. 

— Locking Kit (U3021-60003) for the test set. Includes the Locking kit 
(5023-0132) and screws (0515-2317) to connect the test set to the 
N5224/25/27A/B PNA or N5244/45/47A/B PNA-X. The N5242-20130 is 
the right foot and N5242-20131 is the left foot.

1. Remove the feet from the bottom of the analyzer.

2. Remove the two lower standoffs from the rear panel on the analyzer.
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Figure 1-10 Rear Bottom Feet

3. Install the two rear locking feet from the (5023-0132) onto the analyzer,
where the standoffs were removed.

Figure 1-11 Install Locking Feet on Network Analyzer

4. Remove the top two standoffs from the rear panel on the test set.

5. Install the two rear locking feet from the kit (U3021-60002) onto the test
set using two screws (0515-2317), included in shipment. Looking at the
rear panel, the N5242-20139 is the left foot and the N5242-20138 is the
right foot.

Standoffs (x2)

Feet (x4)

Locking Foot 
from Kit 
(5023-0132)
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Figure 1-12 Rear Locking Feet (N5222A/B or N5242A/B)

N5242-20138N5242-20139

0515-2317 (x2)
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6. Place the analyzer on top of the test set and ensure that the front frame of
the analyzer is positioned slightly forward of the locks that are attached to
the test set. Slide the analyzer back so the locks engage the front frame of
the analyzer.

Figure 1-13 Locking the Analyzer

7. Secure the analyzer’s lower locking feet to the test set’s upper locking feet
using the spring–loaded screws on the locking feet. Refer to Figure 1-14
on page 28. If the locking feet are not aligned with the screw holes in the
test set's upper locking feet, loosen the screws securing the feet to the
instrument slightly to align and tighten.

Test Set
Front Frame

Network Analyzer
Front Frame

Slide the network Analyzer
back to engage the lock link
n the back of the netwo

Lock Link
screw

Slide the network analyzer
back to engage the lock link in 
the back of the network 
analyzer's front frame
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Figure 1-14 Locking Feet Screws 

Locking Screw  Locking Screw 

 N4011-21002 
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Rear Panel Connections

Rear panel connections are documented in Figure 1-15 through Figure 1-20. Refer to 
Table 1-4 on page 13 and Table 1-5 on page 14 to determine which figure applies to your 
configuration. 

Figure 1-15 N5261A Rear Panel Configuration A

From:
PNA/PNA-X

D/R2 C/R1 Test Set I/O LO OUT (J5) B A

To: N5261A 
Controller

D C Test Set I/O LO IN B A



30   Keysight N5261/62A User’s & Service Guide

Installation & System Operation 

1-

Figure 1-16 N5262A Rear Panel Configuration B

From:
PNA/PNA-X

D/R2 C/R1 R Test Set I/O LO OUT (J5) B A

To: N5262A 
Controller

D C R Test Set I/O LO IN B A
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Figure 1-17 N5261A Rear Panel Configuration C

From:
PNA/PNA-X

D/R2 C/R1 Test Set I/O LO OUT (J5) B A SW SRC1 
OUT (J11)

1. Install the adapter (N4903-61250) on the N5224/25A/B or N5244/45A/B SW SRC OUT (J11).

To: N5261A 
Controller

D C Test Set I/O LO IN B A SRC 1 RF IN (Port1 
SW SRC)
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Figure 1-18 N5262A Rear Panel Configuration D

From:
PNA/PNA-X

D/R2 C/R1 R Test Set 
I/O

LO OUT 
(J5)

B SW SRC1 
OUT (J8)

A SW SRC1 
OUT (J11)

1. Install the adapters (N4903-61250) on the N5224/25A/B or N5244/45A/B SW SRC OUT (J8 and J11).

To: N5262A 
Controller

D C R Test Set 
I/O

LO IN B SRC 2 RF IN (SRC 
2 SW SRC) 

A SRC1 RF IN 
(Port 1 SW SRC)
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Figure 1-19 N5261A Rear Panel Configuration E

From:
PNA/PNA-X

D/R2 C/R1 Test Set I/O LO OUT (J5) B A RF 1 OUT
(J6)

To: N5261A 
Controller

D C Test Set I/O LO IN B A SRC 1 RF IN (Port 
1 SW SRC)
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Figure 1-20 N5262A Rear Panel Configuration F

From:
PNA/PNA-X

D/R2 C/R1 R Test Set 
I/O

LO OUT (J5) RF 2 OUT
(J12)

B RF 1 OUT
(J6)

A

To: N5262A 
Controller

D C R Test Set 
I/O

LO IN SRC 2 RF IN 
(SRC 2 SW SRC) 

B SRC1 RF IN 
(Port 1 
SW SRC)

A
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PNA and PNA-X Front Panel Connections

Some system configurations require SRC connections between the analyzer’s 
ports and the front panel of the test set. Refer to Table 1-4 on page 13 and 
Table 1-5 on page 14 to determine if these connections are necessary for your 
configuration. Figure 1-21 and Figure 1-22 provide the connection diagrams.

Figure 1-21 N5261A Front Panel Configuration Y and Z

Figure 1-22 N5262A Front Panel Configuration V and X

A. B.

A. N5262-20016, -20023 (W1) B. N5262-20018, -20026 (W1)

C. D.
E. F.

C. N5262-20016, -20023 (W1)
D. N5262-20020, -20025 (W2)

E. N5262-20018, -20026 (W1)
F. N5262-20019, -20027 (W2)
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Millimeter-wave Module Cable Connections 

Before connecting the millimeter-wave modules, verify that the test set and the 
power supplies (if used) are powered down.

There are four RF cables for each T/R module. Cables provided with the VDI 
modules are pre-labeled. The cables for use with the OML modules come in 
two types, two lighter and two heavier. Use the lighter cables for the IF signals 
and the heavier cables for the RF and LO signals.

Figure 1-23 Example - OML Module Connections

Figure 1-24 Example - VDI Module Connections

DC Bias
REF IF

TEST IF
RF LO

REF IF

M EAS IF
RF

LO

I

O

Power Supply

Each module has 
a separate power 
supply.
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The following detailed instructions are for connecting an OML T/R module. 
These instructions assume a cable dress kit (black sleeving) is available. Modify 
the instructions appropriately for other types of modules.

1. Prepare the cable bundle comprised of five cables listed in Table 1-13.

a. Complete Steps 1 through 5 of the Installation Guide from the
Millimeter-wave Cable Dress Kit (document number N5260-90070
contained in kit part number N5261-60019). DO NOT APPLY THE
VELCRO ASSEMBLIES AT THIS TIME.

2. Connect the five cables to the front panel of the controller in the following
order. Use two right angle adapters (1260-2604).

Figure 1-25 Controller Front Panel Connections

3. Repeat step 1 and step 2 for each module in the system.

Table 1-13 Controller Connections

Order Test Set Module (OML)

1 DC POWER +12 V

2 TEST IF Test I.F.

3 REF IF Ref I.F.

4 RF OUT R.F. In

5 LO OUT L.O. In
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4. Select a Millimeter-wave module and place it on the work surface in front
of the test set.

5. Connect the bundle of cables to the module in the following order.

Figure 1-26 Test Head Module Connections

6. Repeat step 4 and step 5 for the remaining modules.

7. Apply Velcro assemblies to the ends of the cable sleeves.

a. Complete steps 6, 7 and 8 of the Installation Guide from the
Millimeter-wave Cable Dress Kit (document number N5260-90070
contained in kit part number N5261-60019 and N5261-90020).

8. Position each test head in the approximate location where it will be used
for measurement operations.

9. Torque all RF connections to 8 in-lb.

Table 1-14 Millimeter Head Connections

Order Module (OML)

1 +12 V

2 R.F In

3 L.O. In

4 Ref I.F.

5 Test I.F.
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Configuring the Network Analyzer to Millimeter Mode

This section will describe how to set up and operate the N5261/62A Millimeter 
Head Controller with your network analyzer. 

The N5261/62A Millimeter Head Controller is considered a “secondary” 
instrument. A network analyzer must be used to control the test set. 

Before turning on this instrument, verify that the AC supply voltage is in the 
specified range.

Typeface Key Conventions

The following key conventions are used throughout this document.

— [HARDKEYS] are labeled front panel keys.

— SOFTKEYS are indicated on the instrument display.

Before Beginning this Section

Determine the multiplier factors to use for RF IN and LO IN. The factors for 
each head are indicated on the labels located on the top of each head (near 
the RF and LO connectors).

The maximum frequency of RF signals from the PNA-X rear panel is 19 GHz.
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Millimeter Mode 

The Millimeter mode allows you to configure the system for the 
millimeter-wave module you are using. Refer to the analyzer’s Help menu for 
more information. 

The following instructions assume the system has not been configured for the 
desired heads.

1. Connect your system and turn on all of the equipment.

2. To access the millimeter application select [System] > Configure >
Millimeter Module.

3. Select the test set you are using from the drop-down menu (N5261A or
N5262A).

4. Click the New command button.

5. In the “Selected Configuration” dialog box enter a title, such as “WR15” to
replace “Config 1”.

Figure 1-27 Banded Configuration 

6. Enter the Multiplier RF IN number. Example: (WR15 = 4). Refer to Figure 1-28
and the documentation shipped with your module.

7. Enter the Multiplier LO IN number. Example: (WR15 = 5). Refer to Figure 1-28
and the documentation shipped with your module.

8. In the Test Port Frequency dialog box enter the Start and Stop Frequency of
the millimeter-wave module. Example: (WR15 = 50 GHz and 75 GHz)
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9. Select or clear the "Route PNA RF to rear panel 'RF OUT'” check box as 
indicated in Table 1-4 on page 13 or Table 1-5 on page 14.

10. Set the ALC mode according to the following information:

For most applications the ALC mode should be on “Enable Test Set RF
ALC” box checked. For this condition “Max Power Limit at Multiplier’s RF
IN” is automatically set to 11 dBm. The hardware ALC’s in the test set
provide a nominal 11 dBm power level at the RF inputs to the extender
modules. This applies to both the RF and LO inputs. A nominal cable loss
between the test set and extender modules is assumed.

If the ALC mode “Enable Test Set RF ALC” is off, the max power may be set
by the user in the “Max Power Limit at Multiplier’s RF IN” dialog box. If the
user adjusts the analyzer’s RF power, the RF power into the
millimeter-wave modules will change, but will not exceed the specified
max power in the dialog box. It is recommended that ALC “Enable Test Set
RF ALC” be turned off in Pulse mode. Without ALC the power control is
less accurate.

11. Select OK. The analyzer will preset for millimeter operation after you
select OK in the next dialog window.

Figure 1-28 Millimeter System Selections 

Select the “Standard PNA” configuration to return to normal PNA operation 
without the heads. 



42   Keysight N5261/62A User’s & Service Guide

Installation & System Operation 

1-

System Operation Verification

— The Banded System Check verifies the configured system is operating 
correctly. It requires all system components. 

— If a problem is suspected with the N5261A or N5262A test set, refer to 
"Part Replacement and Location Information” on page 50 and 
“Troubleshooting the Test Set” on page 63. 

Banded System Check

The Banded System operational verification procedure confirms that the 
system is operating correctly. There are no hard specifications for the system 
measurement performance, but guidelines are provided for evaluating the 
system operation results. 

The purpose of the Operation Check is to detect significant degradations in the 
system that make the performance unacceptable. The calibration kit and test 
environment can affect the System Operation Check results. Refer to “Site 
Preparation” on page 23.

When any part of the operator’s check provides unsatisfactory results, refer to 
“System Level Troubleshooting” on page 47 to determine the cause of the 
problem.

Required Equipment

— Waveguide Short

— Data for your mm-wave modules receivers

— 3/32 Ball Driver (OML), or 5/64 Ball Driver (VDI)

— 5/16 Open end Torque Wrench, 8 in-lb.

Preparing the Network Analyzer

1. Connect the analyzer, test set and the millimeter-wave band modules as
described in “System Configuration and Operation” on page 23.

2. Turn on the test set and the analyzer.

3. Configure the analyzer for operation with the millimeter-wave modules. 
Refer to “Configuring the Network Analyzer to Millimeter Mode” on page 
39. Refer to the Help menu for further information.
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Procedure

This procedure assumes that you have a Transmission/Reflection module on 
each port. If not, the procedure will have to be modified appropriately.

The Operational Check procedure verifies that the banded system is connected 
correctly and the modules, test set and analyzer are operating properly. 

1. Allow the system to warm up for at least 30 minutes.

2. Attach a waveguide extension section to each module’s waveguide flange
port to protect the modules waveguide connector.

3. Verify that the analyzer is in Millimeter mode and that the frequency range
is correct for the configured millimeter system.

4. To verify the port as a receiver, perform the following steps:

a. Connect a short to Port 1.

b. Display all receivers on the analyzer’s screen using the following
menu selections: [System] > Service > Utilities > Receiver Display.

c. Compare the A,1 and R1,1 traces to the data for your modules' Test
and Reference receivers. The general shape should be similar, but not
necessarily identical to the graphics in the module documentation.
Depending on the PNA model used, there may be a level shift of up to
10 dB. If a waveguide short is not connected the Test Receiver level
will appear to have low amplitude.

d. Next, setup a two stack window display: Display > Layout > Stack 2x. 
A representative view of a Banded System verification display is 
shown in Figure 1-29.

e. Compare the B,2 and R2,2 traces to the data for your modules' Test
and Reference receivers for the millimeter-wave module on Port 2.
The general level and shape should be similar.

f. Repeat step d and step e for Port 3 and compare trace 3 C,3 and R3,3.

g. Repeat step d and step e for Port 4 and compare trace 4 D,4 and R4,4.
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Figure 1-29       Banded System Check 

5. Measure a Thru Connection.

a. Connect the Port 1 to Port 2 module, and Port 3 to Port 4 module
(N5262A) to form thru connections.

b. Delete the trace 1, S11. Select Trace/Chan > Trace > Delete Trace.

c. Select [Preset] > Trace/Chan >Trace > New Trace. Select S12, S21,
S34 and S43. This test confirms that the modules are sourcing and
receiving. Refer to your millimeter-wave modules data from OML or
VDI, included with the your module.

S12 requires a Transmission/Reflection module on Port 1. 
S21 requires a Transmission/Reflection module on Port 2. 
S34 requires a Transmission/Reflection module on Port 3. 
S43 requires a Transmission/Reflection module on Port 4.
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Figure 1-30 Uncalibrated S12 and S21 
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6. Measure the Dynamic Range of each Millimeter-wave module.

a. Measure S11 for a 1-Port system, or S12 and S21 for a 2-Port
system, or S12, S21, S34 and S43 for a 4-Port system.

b. Select [Avg] > IF Bandwidth [10] > [Enter].

c. Set the power level to the maximum for each band.

d. For a 1-Port system connect a short to the test port. For a 2-Port or
4-Port system connect the module ports together to form thru
connections. Refer to “Measure a Thru Connection” on page 44 for
connections.

e. Normalize each trace. Select the trace and press [Memory] >
Normalize.

f. For a 1-Port system remove the TEST IF cable from the test set or
module. For a 2-Port or 4-Port system disconnect the module ports
and connect a load or short to all module ports.

g. Select [Scale] > Reference Level > [−30] > [Enter]. Set the reference
as needed to view each trace.

h. The S11, S12, S21, S34 or S43 traces show non-calibrated system
dynamic range. The dynamic range will vary depending on the
modules used, and the configuration of the system. Reference your
modules document for performance information. See Figure 1-31.

i. Select [Memory] > Data Math > Off and review the traces for noise
floor performance.

Figure 1-31      Dynamic Range Trace Example 
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System Level Troubleshooting
If the System Operation Verification procedure fails, perform the 
following procedure to isolate the problem. 

Refer to the Keysight PNA Series: firmware, Upgrades, and Support at:  
http://na.support.keysight.com/pna for further information. 

To request service, please contact your local service center. In the US, call 
800-829-4444. For a listing of service centers worldwide, please visit us at 
http://www.keysight.com/find/service. 

1. Confirm that each piece of equipment is turned on and that all analyzer
and module connections are correct.

2. Verify that the analyzer has the correct options for Millimeter mode
operation. Refer to “Test Set Accessories” on page 4.

3. Verify that the analyzer is in Millimeter mode for the waveguide band of
the modules used.

4. If the receiver levels (A,B, C, D or R 1) fail the Banded System check refer 
to the Measure, Test and Reference graphs in the documentation included 
with the module. If the REF IF and Test IF levels are low connect the REF IF 
and TEST IF cables directly from the mm-wave module to the analyzer’s 
rear panel IF Inputs. If the levels are correct proceed to step 7. If the levels 
are low continue with step 5.

5. If one of more of the ports are working, substitute the mm-module with a 
known working module. If the port is still not working measure the RF Out 
and LO Out power from the test set’s RF Out and LO Out connectors at the 
end of the cables. Replace or substitute the cables if the loss is greater 
than the cable specification. If the cables are not the cause proceed to 
step 7.

Turn off the test set before disconnecting or reconnecting the modules.

6. Confirm that the analyzer is working properly by disconnecting it from the
test set and performing an Operation Verification (OP VER) in the Help
menu.

7. If the analyzer is operating properly, verify the test set by performing the
“Troubleshooting the Test Set” on page 63.

8. If the analyzer, test set and modules are functioning, but the system is not 
operating properly, contact “Keysight Support, Services, and Assistance” 
on page 92.

http://na.support.keysight.com/pna/
http://na.support.keysight.com/pna/
https://service.keysight.com/infoline/public/default.aspx
https://service.keysight.com/infoline/public/default.aspx
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Part Replacement and Location Information 

There are many other repair and calibration options available from the 
Keysight Technologies support organization. These options cover a range of 
service agreements with varying response times. Contact Keysight for 
additional information on available service agreements for this product.

Replaceable Parts 
Special options are built to order, so long lead times may be 
encountered when ordering replacement parts. For parts that are not 
listed in the following table, refer to Keysight Support, Services, and 
Assistance”on page 92.

Description Keysight Part Number

Millimeter Head Interface Bd N5261-60101

DC Power Bd N5261-60102

RF/LO Bias/ALC Bd N5261-60103

Preamplifier Bias Bd N5261-60104

LED Bd, Front Panel N5261-60005

Test Set Controller Bd N5261-60006

RF 4-way Divider N5262-80003

RF Detector 33330-80021

Coax Cable, Sloped Attenuator N5262-20033

DC Power Supply 0950-4729

RF Isolator, 20 GHz 0955-1595

Preamplifier 5087-7750

RF/LO Amplifier 5087-7771

Coax Attenuator (3 dB) 0955-0246

Coax Attenuator (6 dB) 0955-0243

Coax Attenuator (7 dB) 0955-0242

RF Directional Coupler (2-20 GHz) 0955-0148

RF Switch, SPDT Solid State 5087-7733

Hex Nut 0140-0084

Lock Washer 2190-0067

Fuse 5 A/250V 2110-0709

Cable, IF MUX, front panel 8121-0150

Cable, IF MUX, rear panel 8120-8483
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Test Set Diagrams and Graphics

Figure 2-1 N5261A Test Set Diagram
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Figure 2-2 N5262A Test Set Diagram
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Figure 2-3 N5261A RF and LO Block Diagram1 

1. Refer to Figure 2-1 on page 51 for IF paths.
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Figure 2-4 N5262A RF and LO Block Diagram1

1. Refer to Figure 2-2 on page 52 for IF paths.

N5262A RF Block Diagram

LO IN
8 to 19 GHz

+2 to -10 dBm

Port 3 RF Out
8 to 19 GHz, 10-11 dB 
Gain, +13 dBm Max

Port 3 LO Out
(Leveled) 8 to 19 GHz, 
10.5-11.5 dB Gain

Port 1 RF Out
8 to 19 GHz, 10-11 dB 
Gain, +13 dBm Max

Port 1 LO Out 
(Leveled) 8 to 19 GHz, 
10.5-11.5 dB Gain

SRC 1 IN 8 to 19 GHz

Divider
N5262-80003

Isolator
0955-1595

5087-7750
Pre Amp

7 dB

7.2 dB

Isolator
0955-1595

½ RF Section

Dir Coupler
0955-0148

10dB
Damage 
15 dBm

3dB

LO Section

Dectector

33330-80021

5086-7771

LO Amp Dir Coupler
0955-0148

ALC (Sw’d)

Dectector

33330-80021

5086-7771

Port 1 & 2 RF Amp

ALC (Sw’d)

6 dB

6 dB

5087-7733

Solid
State Sw.

SRC 1

Out

In

Rear
Panel

Front 
Panel

Port 2 RF Out
8 to 19 GHz, 10-11 dB 
Gain, +13 dBm Max

Port 2 LO Out 
(Leveled) 8 to 19 GHz, 
10.5-11.5 dB Gain

SRC 2 IN 8 to 19 GHz

Isolator
0955-1595

½ RF Section

Dir Coupler
0955-0148

10dB
Damage 
15 dBm

3dB

Dectector

33330-80021

5086-7771

Port 3 & 4 RF Amp

ALC (Sw’d) 6 dB

Sloped Attn 
CA-AY

5087-7733

Solid 
State Sw.SRC 2

Out

In

Port 4 RF Out
8 to 19 GHz, 10-11 dB 
Gain, +13 dBm Max

Port 4 LO Out
(Leveled) 8 to 19 GHz, 
10.5-11.5 dB Gain

Isolator
0955-1595

Bias 
Bd

N5262-20033

Sloped Attn 
CA AY

N5262-20033

N5261-60104

N5261-60103

N5261-60103

N5261-60103

54   Keysight N5261/62A User’s & Service Guide



Service Information

2-

Figure 2-5 Signal Routing 2-Port

Figure 2-6 Signal Routing 4-Port
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Figure 2-7 N5261A Top View
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Figure 2-8 Sloped Attenuator Cable Assembly
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Figure 2-10 N5262A Top View1

1. Refer to Figure 2-2 on page 52 for IF cable routing between the Interface board and the front and rear panels.
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Figure 2-11 N5261/62A Bottom View
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Theory of Operation 

Functional Block and Assembly Information 

The N5261A/62A routes PNA-X LO and RF signals to a millimeter-wave 
module. This allows the PNA-X to up-convert for a millimeter-wave source and 
down-convert a received millimeter-wave frequency to an IF frequency 7.6 
MHz. It also provides the DC power for the millimeter-wave module. The 
following components are used in the N5261/62A. Refer to the block 
diagrams, Figure 2-3 through Figure 2-6 beginning on page 53.

Test Set Control Board (N5261-60006)

The Test Set Control board (N5261-60006) is a surface mount, printed circuit 
assembly (PCA) that provides a connection to the power supply and the PNA-X 
Test Set I/O. The PNA-X sends address and data commands which are read by 
the test set controller for selecting the switch paths of the SRC1 and SRC2 RF 
and IF switch paths. The test set controller board has a programmed FPGA and 
memory (NovRam) with model number and gain correction values for the 
Amplifiers and ALC circuits. Switch S1 is set to lock the memory after 
calibration is been loaded. The front panel “Active” and port LEDs are only on 
when the PNA-X has addressed the N5261/62A Millimeter Head Controller. 
The rear panel fan is on when the Controller board supplies are operational. 

IF the Controller board is replaced, the gain data will need to be stored into the 
new board. Refer to “Contacting Keysight” on page 92 for the replacement 
procedure.

Interface Board (N5261-60101)

The Interface board is installed on top of the test set controller board. It 
provides switch drive signals and voltage for the solid-state switches that 
select RF Inputs (SRC1 or SRC2) to one of the front panel RF Outputs ports. It 
provides switching from the front panel TEST IF and REF IF Inputs to the rear 
panel IF Outputs D/R2 C/R1, R, A, B. The board also provides DC voltage, ALC 
control of the Amplifiers and a FPGA programmed device that enables 
N5261/62A Millimeter Head Controller operation.

LED Board (N5261-60005)

Two LED board assemblies are mounted to the front panel. The top LED board 
indicates the Source Path (amber/yellow color), or Receiver Path (green 
colored) shown as “S” and “R” for each port. The bottom LED Board indicates 
the DC Power is on (green). If an over-current condition occurs on the 
millimeter-wave module the LED will be (amber/yellow), which could be a 
result of a shorted interface cable or damaged Millimeter-wave module. The 
LED board assemblies are connected to the test set controller board by ribbon 
cables. 
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DC Power Board (N5261-60102)

The DC Power board provides connection to the power supply and self 
recovering fuses for each millimeter-wave module supply (+12 volt) on the 
front panel. The fuses are reset when the N5261/62A is turned off. 

Power Supply (0950-4729)

The power supply (0950-4729) coverts the AC line voltages to DC. This is an 
automatic line voltage selecting power supply. The AC line voltage (100 to 240 
V @ 50/60 Hz) is provided from the line module located on the rear panel. 

Isolators (0955-1595)

Isolators are installed in the LO Output RF path for each port. These 10 watt 
isolators maximizes the LO power input to the millimeter-wave modules over a 
frequency range of 8 to 19 GHz.

LO Preamplifier (5087-7750)

A preamplifier installed in the LO Input path provides a higher RF power level 
required for the 
LO Amp. 

RF and LO ALC Amplifier (5087-7771)

The Mod/Amp has adjustable gain that provides ALC leveling for the front 
panel RF and LO Output signals. Adjustments are made on each Mod/Amp to 
set the maximum output power to +12.0 or +12.5 dBm (R3). The output of each 
amplifier is connected to a coupler, and with a detector for ALC, the mod/amps 
provide RF and LO leveling. Each Mod Amp has a Bias board (N5261-60103) 
installed on top that provides the power supply connection and circuitry for 
setting the gain of the amplifier (R3) and an SMB Input to the modulator.

The ALC function for the LO is always enabled. The ALC function for the RF 
sections may be turned off. The test set controller board stores open loop gain 
values for the RF sections. These gain values are used by the PNA firmware to 
provide a power level of approximately 10 dBm to the mm-wave heads when 
the ALC function is off.

Attenuator, 7 dB (0955-0242)

This attenuator is used at the LO Input port to provide a good match and set 
the LO Input level for the preamplifier. 

Attenuator, 6 dB (0955-0243)

The 6 dB attenuators are used to attenuate the RF and LO power to the ALC 
detector to set the RF level for linear operation. 

Attenuator, 3 dB (0955-0246)

The 3 dB attenuators are used in the SRC1 or SRC2 Mod/Amp Inputs to 
provide a good match and ensure it does not exceed +15 dBm. 
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Coupler (0955-0148)

Directional couplers with 10 dB coupling factor are used for ALC feedback for 
RF and LO Output leveling.

Slope Attenuator Cable Assy (N5262-20033)

A slope pad is installed on the leveling coupler of the RF Out path to 
compensate for the RF switch loss at higher frequencies.

Power Divider (N5262-80003)

A four-way power divider provides each Port LO Output from the LO amplifier 
with approximately 7.2 dB attenuation for each LO Out. Two 50 ohm 
terminators are installed on the unused N5261A divider paths. If a system is 
configured with a unused port (a 1-Port reflection system for example) the front 
panel LO Output ports are to be terminated with a 50 ohm load (1810-0118). 
This keeps the power divider balanced and prevents an “open” reflective signal 
from entering the power divider and mixing with the RF signal.

RF Switch (5087-7733)

A solid-state switch with internal 50 ohm termination is used for switching the 
RF Output path for Ports 1 and 2, or Ports 3 and 4. These switches are 
controlled by the test set controller and interface boards.
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Troubleshooting the Test Set
For assistance refer to “Keysight Support, Services, and Assistance” 
on page 92.

If the test set is not operating properly, use the following procedures to aid in 
isolating the problem. Refer to the “Test Set Diagrams and Graphics” 
starting on page 51. 

Troubleshooting, DC Level

            Power Supply and Fans

1. Verify the front panel Standby switch is operational.

a. The rear panel fan and front panel DC Power LEDs should be on
when the Standby switch is in the on position.

2. AC Line voltage checks.

a. Ensure the proper AC line voltage is present at the instrument line
cord.

b. Remove the AC power cord from the instrument. Check the
instrument AC line module 5 amp fuse, as shown in Figure 1-7 on
page 11.

c. Remove the instrument bottom cover. Near the rear panel are two
fuse holders, remove the 8 amp fuses and verify that they are
operational. See Figure 2-11 on page 59.

Keysight N5261/62A User’s & Service Guide   63

3. External DC Power checks.

Verify DC voltage levels on each of the front panel DC power 
connectors. Pins 1 & 3 = +12 V (± 0.8 V), Pins 4 & 6 = ground

1 3

6 4

2

5

7

Pin 1 (+12V)

Pin 6 (gnd)

Pin 3 (+12V)

Pin 4 (gnd)

a.

Figure 2-12 Front Panel Millimeter Module DC Power Connector



4. Internal DC Power checks.

a. Set the Standby switch to the Standby position.

b. Remove the top cover and connect the AC power cord. No fans or
DC power LEDs should be on.

c. Set the Power Switch to the on position. Both rear panel and
internal power supply fans should be operational.

d. Ensure the Controller board DC Supply indicator LEDs are on. If not,
suspect power supply (0950-4727) or front panel Standby switch.
Using a DVM measure the power supply terminal connections. Refer
to the label on the power supply for voltages on the terminals
screws. Figure 2-13 on page 66.

b. If no DC voltages are present at the front panel, remove the top and
bottom covers.

c. Inspect the DC Power board (N5261-60002) connections.

d. Measure the +12 Vdc (red wires) on the DC Power board. If the +12 Vdc is
present, replace the DC power cable from the front panel (N5652-60001).
If the +12 Vdc is not present go to step 4.

e. Verify that the supply LED indicators on the Test Set Control Board
(N5261-60006) are on. If they are, replace the DC Power Board
(N5261-60002). Refer to Figure 2-7 on page 56. If the LEDs are not off,
refer to “Troubleshooting the Test Set” on page 63.

e. If the voltages on the power supply are correct, lift the Interface
board. If the Controller board DC Supply LEDs are on, disconnect
switches (J60 & J61) and amp cables (J10, 11, 12 and 14) to the
Interface board and re-install the board. If the indicator LEDs are on,
suspect the switch or amplifier. See Table 2-1 on page 66.

f. If the fan is not working and all Controller board DC Supply LEDs are
on, replace fan.
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Overcurrent LEDs are On (Amber)

1. Remove all millimeter module connections from the front panel. If the over
current LEDs are off, suspect the millimeter module or the DC Power Bias
cable. If the LEDs are on continue with step 2.

2. Verify that the +12 Vdc on the front panel DC Power connectors is not
shorted to ground. Refer to “Part Replacement and Location Information”
on page 50. If it is shorted to ground, replace the front panel DC Power
cable (N5652-60001) or the DC Power Board (N5261-60002). If it is not
shorted to ground continue to step 3.

3. Move the DC Power board ribbon cable to the Source/Receiver Status LED
board, if the over current LEDs are still on replace the DC Power Board
(N5261-60002). If the LEDs are off replace the DC Power LED Board
(N5261-60005).

            Front Panel Active and Port Status LED

Front Panel R and S Indicator LED check. If the LED indicators are not 
operating, verify the ribbon cable connection and ensure the rear panel test set 
interface cable is connected securely. Proceed to the next section for further 
troubleshooting before replacing the front panel board.

1. Connect the Test Set I/O cable (N4011-21002) from the analyzer to the
test set.

2. Using the I/O command values, confirm the correct address and data 
values are used, refer to Table 2-3 on page 76.

3. Front Panel R and S indicator LED Check.

a. Verify that at least three of the Controller Status LEDs, are on. Refer
to Figure 2-13 on page 66.

b. If none are on remove the Switch Driver board and recheck, if still no
indication, replace the Controller board.

c. If the Controller Status LEDs and the front panel Active LED is on,
suspect the front panel LED board or the ribbon cable. Replace as
needed. You can move the ribbon cable connection to the DC power
board and verify if the problem is the Port Status LED board, or use
the ribbon cable from the DC power board to verify if the problem is
the ribbon cable.
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Figure 2-13 DC Power Check Locater

Table 2-1 Interface Board DC Power Distribution Details 

Ref Des Load DC Voltage DC Source

J10 RF Amp1 2, −2, 9, 15, −15 Main PS U22 & U23

J11 RF Amp2 2, −2, 9, 15, −15 Main PS U22 & U23

J12 LO Pre Amp 15 Main PS

J14 LO Amp 2, −2, 9, 15, −15 Main PS U22 & U23

J60 RF Sw1 −10 & 13 U20 & U21

J61 RF Sw2 −10 & 13 U20 & U21

66   Keysight N5261/62A User’s & Service Guide



Service Information

Troubleshooting, RF Level

            RF Out Failures

If the test ports are not switching, or fail the Operational Check the following 
procedures can be used to verify the failure. The procedures assume power 
supplies, controller board and front panel LEDs are working. Suspect the 
switch Interface board, ribbon cable connection or RF switch. Refer to Table 
2-1 on page 66 and Figure 2-13 on page 66.

1. Inspect the ribbon cable connections from the RF switches to the Switch
Interface board (N5261-60001). Ensure the RF jumpers (E8356-20072) are
installed on SRC1 IN/OUT and SRC2 IN/OUT on the rear panel.

2. Start by measuring the power at SRC1 or SRC2, continuing through the RF 
Amp, Directional Coupler, and Solid State Switch. If you find incorrect 
power levels and suspect a component has failed, verify the DC voltages 
referencing Table 2-1 on page 66 and Figure 2-13 on page 66. Replace the 
failed component.

If you suspect the RF Amp (5086-7771) substitute the LO Amp
(5086-7771) to verify the failure. The RF Amp uses a leveling circuit with
directional coupler and detector that also can be checked before replacing
the RF Amp. You may also substitute the Directional Coupler and Detector
from the LO Amp section. If the RF Amp is replaced, a gain calibration must be
performed.

3. If you suspect the Solid State Switch (SW1 & SW2), confirm that one of its 
two LEDs toggle on/off when you send a Test Set I/O command. Refer to 
“Measure RF OUT (Gain and Power)” on page 73 and Table 2-3 on page 76.

4. Substitute a known good switch, or connect a known good wire-harness
cable and retest. Replace if necessary.

5. If the problem is not the switch, measure the switch drive voltage on the 
Interface board (J60 or J61, Pin 1) for a change in voltage (−10 V or +13.0 V), 
use I/O command in Table  2-3 on page 76. Replace the Interface board.

LO Out Failure

If the LO Out fails the Operation Verification test the following procedure can 
be used to verify the failure. The procedures assume power supplies, 
controller board, and front panel LEDs are working. Suspect the switch 
Interface board, Bias cable, RF pre-amp, or Power Divider. 

1. If one or more of the LO ports are working, suspect the Power Divider.

2. If none of the ports are working, start by measuring the power at LO IN, 
continuing through the pre-amplifier, LO Amp, Directional Coupler, and 
Power Divider. If you find incorrect power levels and suspect a component 
has failed, verify the DC voltages referencing Table 2-1 on page 66 and 
Figure 2-13 on page 66. Replace the failed component.
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If you suspect the LO Amp (5086-7771), substitute the RF Amp 
(5086-7771) to verify the failure. The LO Amp uses a leveling circuit with 
directional coupler and detector that also can be checked before replacing 
the LO Amp. You may also substitute the Directional Coupler and Detector 
from the RF Amp section. 

REF IF or Test IF Failure

If the REF IF or Test IF fails the Operation Verification test the following 
procedure can be used to verify the failure. The procedures assume power 
supplies, controller board and front panel LEDs are working. Suspect the 
switch Interface board or coaxial cables. Refer to Table 2-1 on page 66 and 
Figure 2-13 on page 66.

1. N5261A - Verify that the front panel Port 1 & 2 REF and IF coax cables are
properly connected to the rear panel (A, B, C and D) and insertion loss is
not > −2.5 dB. Replace the coax cable if defective. Refer to Figure 2-1 on
page 51.

2. N5262A - Verify that the front panel Port 1 & 4 REF and IF coax cables and
rear panel coax cables (A, B, C, D and R) are properly connected to the
Interface board. Verify that the insertion loss is not > −2.5 dB. Replace the
coax cable if defective.

3. If the coax cables are properly connected and the insertion loss is correct,
replace the Interface board. Refer to Figure 2-2 on page 52.

Test Set Operation Check 

This chapter contains service information for a standalone N5261A 
and N5262A controller test sets.

The following procedure verifies the test set without mm-module 
system components. 

The instructions below generally assume a 4-Port N5262A. If you are 
using an N5261A, omit Ports 3 and 4.

Preparation

Required Equipment 

— PNA, PNA-L, PNA-X capable of 20 GHz. (The required Test Set I/O interface 
is included with all models). The PNA, PNA-L or PNA-X will be referred to as 
the PNA throughout this procedure. 

— Two RF flexible cables with 3.5 mm male connectors (5062-6696 or 
equivalent). One cable must be long enough to comfortably connect 
between the PNA and the rear panel of the test set.

— Three SMA or 3.5 mm adapters (female to female)
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— Voltmeter

— Power sensor and compatible power meter. The power sensor must be 
capable of measuring from −10 dBm to +15 dBm at a frequency of 8 GHz. A 
E4413A power sensor may be used.

Power Sensor and Power Meter Preparation

The power sensor and power meter must be prepared to make measurements 
at 8 GHz. This may include calibrating the power sensor with the meter and 
entering a calibration factor for 8 GHz.

PNA and Test Set Preparation

1. Connect the Test Set I/O cable from the PNA to the test set.

2. Turn on the PNA and the test set.

3. The PNA must be in “Standard PNA” mode. To check the mode, select
Utility > System > Configure > Millimeter Module Configuration. The
Millimeter Module Configuration window will be displayed. “Standard
PNA” should be the Selected Configuration. If not, click on “Standard PNA”
in the list of Available Configuration(s) then click OK.

PNA Normalization Calibration

This procedure prepares the PNA to for path loss measurements.

1. Select [Preset] on PNA.

2. Set the Start and Stop frequencies (8-20 GHz).

3. Set the desired power output level to -10 dBm.

4. Set to measure S12.

5. Connect an RF cable to PNA Port 1. Connect a second RF cable to PNA
Port 2.

6. Connect the two RF cables together with an adapter.

7. Normalize the trace, Select [Memory] > Normalize or select [Data] >
Normalize. You will see a flat line at 0 dB.

8. Remove the adapter between the RF cables.
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Controlling the Test Set Using Test Set I/O Commands

A Test Set I/O command may be used when the PNA is connected to the Test 
Set via the Test Set I/O cable. Commands may control the test set or read data 
from the test set. The GPIB command processor utility, in the network analyzer 
software, is used to communicate over the Test Set I/O connector.

It is recommended to use a USB keyboard with a PNA when using the 
command processor.

Using the GPIB Command Processor 

— Select Utility > System > Configure > SICL/GPIB/SCPI, then GPIB Command 
Processor Console. In the dialog box type the command text and then Enter 
on the keyboard to execute the command. 

— A write command is of the form: cont:ext:test:data n,m   "n" is the address 
and "m" is the data to be written. Typically these values may be any number 
up to three digits in length.

— A read command is of the form: cont:ext:test:data? n    "n" is the address. A 
read command returns a single numeric value.

— Pressing F3 on the keyboard will recall a previously sent command line for 
editing. 

— As a check, send the command: cont:ext:test:data? 0   <enter>. A 61 or 62 
should be returned, depending on the model number of the test set.

— An active command processor window may be minimized via the "_" in the 
upper right hand corner of the window. To access a minimized command 
processor window, minimize the PNA window. Select File > Minimize 
Application.

Test Set I/O Commands

When troubleshooting the Test Set, I/O commands issued by the PNA will be 
used.
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Test Set I/O Command List

The following commands are available for controlling/reading the test set. The 
step-by-step commands in the Part Replacement and Location Information 
procedure require the use of these commands. The user is required to select 
the appropriate command, depending on the port or function under test.

Read commands involve a single number, an address. Write commands involve 
two numbers, address and data.

The amber Source LEDs are controlled separately from the switches for the 
RF OUT paths. 

The write commands for IF path control for the N5262A are listed in Table 2-3 
on page 76. The commands for reading and writing gain factors for are listed in 
Table 2-5 on page 81.

Table 2-2 I/O Commands

0 

32,0

32,1

32,2

address for reading two digits from model number of the test set 

turns on ALC for both SRC1 (Port 1 and 2) and SRC2 (Port 3 and 4) 

turns off ALC for SRC1 (Port 1 and 2) 

turns off ALC for SRC2 (Port 3 and 4)

0,1 SRC1 IN to Port 1 RF OUT

0,2 SRC1 IN to Port 2 RF OUT 

0,16 SRC2 IN to Port 3 RF OUT

0,32 SRC2 IN to Port 4 RF OUT 

64,17

64,34

64,68

64,136

turns on Receiver and Source LEDs for Port 1 (all other LEDs off) 

turns on Receiver and Source LEDs for Port 2 (all other LEDs off) 

turns on Receiver and Source LEDs for Port 3 (all other LEDs off) 

turns on Receiver and Source LEDs for Port 4 (all other LEDs off)
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Measure LO OUT (Gain and Power)

Prepare the PNA to measure S12 with a normalization calibration. Refer to 
“PNA Normalization Calibration” on page 69. Use a frequency range of 8 to 
20 GHz and a power level of −10 dBm. The cable on PNA Port 2 must be 
long enough to reach the rear panel of the test set. 

1. Connect the PNA Port 2 cable to the rear panel LO IN.

2. Connect PNA Port 1 to Port 1 LO OUT on the test set. Verify the LO Output 
gain is > 20 dB. The trace should be within 10 dB of “flat” and have no 
significant holes or discontinuities. Refer to Figure 2-14 below.

3.

Select [Sweep] > Sweep Type > CW Time. Set the sweep time to 10 seconds.4.

5. Disconnect the cable from LO IN and measure the power at the end of the
cable using a power sensor. The power should be in the −8 to −12 dBm
range. Adjust the PNA power output level if needed. Reconnect the cable
to LO IN.

6. Measure the Port 1 LO OUT power using a power meter. The power should
be +12 dBm (± 1.5 dB). Measure LO OUT for the other ports on the test set.

Figure 2-14 LO Output Gain with −10 dB Input 

Move PNA Port 2 cable to Port 2 LO Out and confirm a similar result.
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Measure the SRC1 & SRC2 RF Paths

The following procedure verifies SRC1 and SRC2 internal cables between the 
front and rear panels.

Prepare the PNA to measure S12 with a normalization calibration using a 
frequency range of 8 to 20 GHz and a power level of −8 dBm. See “PNA 
Normalization Calibration” on page 69. The cable on PNA Port 2 must 
be long enough to reach the rear panel of the test set. 

1. Remove the SRC1 RF IN to SRC1 RF OUT rear panel jumper.

2. Connect the PNA RF Port 1 to SRC1 RF IN on the front panel.

3. Connect Port 2 to the rear panel SRC1 RF OUT.

4. The maximum loss should be < 2.5 dB.

5. Repeat the steps above with appropriate modification to measure the
SRC2 path, the maximum loss should be < 2.5 dB.

Measure RF OUT (Gain and Power)

The following procedure measures gain.

Prepare the PNA to measure S12 with a normalization calibration. Refer to 
“PNA Normalization Calibration” on page 69. Use a frequency range of 8 to 20 
GHz and a power level of 2 dBm.

1. Re-install the SRC1 RF IN to SRC1 RF OUT and the SRC2 RF IN to SRC2 RF
OUT rear panel jumpers.

2. Connect PNA Port 2 cable to SRC1 RF IN on the front panel.

3. Connect the PNA Port 1 cable to the Test Set Port 1 RF OUT.

4. Issue the Test Set I/O commands 32,0 and 0,1 (enable ALC and output to
Port 1). Verify that the gain is greater than 10 dB at all frequencies and
there are no holes or significant discontinuities in the trace. Refer to Figure
2-15 on page 74.

5. Issue the Test Set I/O command 32,1 (disable ALC on Port 1). Verify that
the gain increases at all frequencies and that there are no holes in the
trace. Refer to Figure 2-16 on page 74.

6. Repeat the previous the previous four steps for each of the remaining test
set ports using appropriate SRC1/2 connections and appropriate Test Set
I/O commands.

The following procedure measures the power output level.

1. Select [Sweep] > Sweep Type > CW Time. Set the sweep time to
10 seconds.

2. Connect PNA Port 2 cable to the power sensor.
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3. Set the PNA power output level to get a power meter reading of 2 dBm ± 1dB.

4. Connect the PNA Port 2 cable to SRC1 RF IN on the front panel.

5. Issue the Test Set I/O commands 32,0 and 0,1 (enable ALC and output to
Port 1).

6. Measure the Port 1 RF OUT power using the power sensor. Confirm that RF
OUT is +12.5 dBm (± 1.5 dB).

7. Repeat the previous three steps for each of the remaining test set ports
using appropriate SRC1/2 connections and Test Set I/O commands.

Figure 2-15 RF Output Gain with +2 dBm ALC On

Figure 2-16 RF Output Gain with +2 dBm ALC Off
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Measuring Test IF and REF IF Path Loss on the N5261A

The IF paths for the N5261A are not switched, see Figure 2-1 on page 51.

The cable connected to PNA Port 1 must be long enough to reach the rear 
panel of the test set.

1. Prepare the PNA to measure S12 with a normalization calibration. Select a 
frequency range of 10 to 20 MHz and a power level of −20 dBm. See “PNA 
Normalization Calibration” on page 69.

2. Measure the IF signal paths listed below. Connect PNA Port 2 cable to the
test set front panel and the PNA Port 1 cable to the rear panel IF OUT.
Maximum loss should be < 0.5 dB.

— Port 1 TEST IF to A (rear panel)

— Port 1 REF IF to C (rear panel)

— Port 2 TEST IF to B (rear panel)

— Port 2 REF IF to D (rear panel)

Measuring Test IF and REF IF Path Loss on the N5262A 

The IF paths for the N5262A are switched (i.e. multiplexed), see Figure 2-2 on 
page 52.

The cable connected to PNA Port 1 must be long enough to reach the rear 
panel of the test set.

1. Prepare the PNA to measure S12 with a normalization calibration. See 
“PNA Normalization Calibration” on page 69. Select a frequency range of 
10 to 20 MHz and a power level of −20 dBm. See “PNA Normalization 
Calibration” on page 69.

2. Measure each path listed in Table 2-3 on page 76 for N5262A. Each path 
is defined by entries in the “From:” and “To: N5262” columns.

- For a given IF path, issue the appropriate command then measure the
gain (loss) and connect PNA Port 2 to the appropriate connection on the
front panel of the test set.

- The maximum path loss is listed for each path.

- There should be no holes or significant discontinuities on the traces. 
Figure 2-17, Figure 2-18 and Figure 2-19 on page 77 are examples of 
acceptable traces.
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Table 2-3 IF Path Measurement 

From: TEST IF 
Front Panel

To: N5261A Rear 
Panel IF OUT

To: N5262A Rear 
Panel IF OUT

Command1 Max Path Loss for 
N5262A (dB)

Port 1 TEST IF A A 16,8 3

Port 2 TEST IF B B 16,4 3

Port 3 TEST IF n/a C 16,2 3

Port 4 TEST IF n/a D 16,1 3

Port 1 REF IF C D 16,8 6.0

Port 1 REF IF n/a R 16,33 7.5

Port 2 REF IF D C 16,4 6.0

Port 2 REF IF n/a R 16,2 7.5

Port 3 REF IF n/a A 16,2 6.0

Port 3 REF IF n/a R 16,56 7.5

Port 4 REF IF n/a B 16,1 6.0

Port 4 REF IF n/a R 16,20 7.5

1. Commands are not required for the N5261A.
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Figure 2-17 Test IF Path to A, B, C or D (N5262A)

Figure 2-18 Ref IF to A, B, C or D (N5262A) 

Figure 2-19 Ref IF to R (N5262A)
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Test and Adjustment Procedures
The “Test Set Operation Check” on page 68 should be performed 
whenever any active electronic part is replaced in the test set. 

Additional procedures are required when certain components are 
replaced. Table 2-4 indicates when additional procedures are required. The 
additional procedures depend on the location of the replaced component.

The additional procedures are indicated as A, B, C, D, F, Q, R, S and Z 
in Table 2-4. 

The procedures referenced above may be found on the following pages. Many 
of the steps require familiarity with the “Preparation” section beginning on 
page 68.

Table 2-4 Additional Required Procedures for Assemblies Replaced

Description of the Replaced 
Component

Keysight 
Part Number

Location:
Ports 1 & 2 
RF Section1

Location:
Ports 3 & 4 
RF Section1

Location: 
LO Section

General 
Location

Millimeter Head Interface Bd N5261-60101 Z

Test Set Controller Bd N5261-60006 C2  D

RF/LO Bias/ALC Bd N5261-60103 Q R S

Preamplifier Bias Bd N5261-60104 S

RF 4-way Divider N5262-80003 S

RF Detector 3333-80021 Q R S

Coax Cable, Sloped 
Attenuator

N5262-20033 Q R

Preamplifier 5087-7750 S

RF/LO Amplifier 5087-7771 Q A  D R  B D S

RF Directional Coupler 0955-0148 Q A  D R  B D S

RF Switch, SPDT Solid State 5087-7733 Q A D R  B D

1. Refer to Figure 2-2 thru Figure 2-5 and Figure 2-8 thru Figure 2-11 to determine part location. 
2. Procedure “C” must be done before removing the “old” board. 
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Gain Factors for the SRC RF Paths

Background

The controller board in the test set stores gain factors for the various SRC RF 
paths in non-volatile memory. These gain factors are used by the PNA firmware 
to ensure that the SRC RF power delivered to the mm-wave head is 
approximately 11 dBm when the ALC is off.

When a component in a SRC RF path is replaced it is necessary to measure the 
new gain factors and update the values stored on the controller board. Typically 
the gain factors must be updated whenever one or more of the components in an 
“RF Section” of Figure 2-3, “N5261A RF and LO Block Diagram” or Figure 2-4, 
“N5262A RF and LO Block Diagram” is replaced.

When a controller board is going to be replaced, if possible, the gain factors 
should be read from the old controller board before it is removed from the test 
set. After the new controller board is installed the gain factors must be written 
into the test set. If the gain factors cannot be read from the old board then the 
gain factors must be measured after the new controller board is installed.

Instructions for issuing Test Set I/O commands are contained in the 
“Preparation” section beginning on page 68. Table 2-4 on page 78 
indicates which procedure(s) is required.

Measure Gain Factors for Ports 1 and 2 (Procedure A)

1. Connect the SRC 1 jumper on the rear panel of the test set.

2. [Preset] the PNA. Set the measured frequency range from 7 GHz to 20
GHz.

3. Set the PNA power output level to −15 dBm. Set the PNA to measure S12.

4. Connect cables to PNA Ports 1 and 2. These two cables will allow
connection to the front panel of the test set.

5. Connect the two cables together using an adapter and perform a
normalization calibration. Refer to “Part Replacement and Location
Information” on page 50 for instructions.

6. Connect PNA Port 2 to SCR1 IN and PNA Port 1 to Test Set Port 1 RF OUT.

Issue the Test Set I/O commands 32,1 and 0,1 (turn off SRC1 ALC and set
path to Port 1).

7. Set markers for 7, 10, 15 and 20 GHz on the PNA trace.

8. Read the value for each marker and translate to tenths of a dB (round the
raw number as required). Example: a reading of 25.34 dB would be
translated to a value of 253.

9. Record the values for Port 1 in Table 2-5 on page 81.

10. Issue the Test Set I/O command 0,2 to set the path to Port 2.
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11. Move the PNA Port 1 cable to Test Set Port 2 RF OUT.

12. Record the values for Port 2 in Table 2-5 on page 81 .
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Measure Gain Factors for Ports 3 and 4 (Procedure B)

Repeat the process above for Ports 3 and 4 with the following modifications:

— Connect the SRC2 jumper on the rear panel.

— Connect to SRC2 IN in place of SRC1 IN.

— The first set of Test Set I/O commands should be 32,2 and 0,16.
(turn off SRC2 ALC and set the path to Port 3)

— The Test Set I/O command to set the path to Port 4 is 0,32.

Table 2-5 Gain Factor Addresses and Values

Ports/Freq Write 
Address

Read Address Value

Port 1 - 7 GHz 144 16

Port 1 - 10 GHz 148 20

Port 1 - 15 GHz 152 24

Port 1 - 20 GHz 156 28

Port 2 - 7 GHz 160 32

Port 2 - 10 GHz 164 36

Port 2 - 15 GHz 168 40

Port 2 - 20 GHz 172 44

Port 3 - 7 GHz 176 48

Port 3 - 10 GHz 180 52

Port 3 - 15 GHz 184 56

Port 3 - 20 GHz 188 60

Port 4 - 7 GHz 192 64

Port 4 - 10 GHz 196 68

Port 4 - 15 GHz 200 72

Port 4 - 20 GHz 204 76
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Read Gain Factors from the Test Set (Procedure C)

Issue a separate Test Set I/O read command for each entry in Table 2-5 on 
page 81. Record each value as it is read from the test set. As an example, 
to read the value for Port 2 at 10 GHz, issue the following command: 36. 
The command will return the value stored in the test set. The value is an 
integer representing tenths of a dB. Ignore the leading “+”.

Write Gain Factors to the Test Set (Procedure D)

A slide switch must be accessed to enable writing of gain factors. The switch is 
located on the test set Control Board next to U5, close to the rear panel. (The 
test set controller board is shown in Figure 2-10 on page 58) “NWE” and 
“NCLR” labels are silk-screened near the sides of the switch. To enable 
writing, slide both sections of the switch toward U5. To disable writing, slide 
both sections of the switch away from U5. The switch may be covered with 
soft, transparent plastic. A sharp, stiff tool may be required to manipulate the 
switch.

Enable writing via the slide switch.

Issue a separate Test Set I/O write command for each entry in Table 2-5. As an 
example, to write a value of "253" for Port 1 at 7 GHz, issue the following 
command: 144,253.

It is only necessary to write “new” values. If only Procedure A has been 
performed and not Procedure B, then only values for Ports 1 and 2 need to be 
written. If a test set controller board has been replaced, then values for all four 
ports must be written for an N5262A.

Disable writing via the slide switch when this procedure is complete.
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Adjust ALC Levels

Background

When a component is changed in an RF or LO signal path, it is often necessary 
to adjust the ALC level for the path. See Table 2-4 on page 78 for required 
adjustments when a part is replaced.

PNA and Power Sensor Preparation

A power sensor and power meter must be prepared to make measurements at 
8 GHz. This may include calibrating the power sensor with the meter and 
entering a calibration factor for 8 GHz.

1. Set the PNA to measure S12.

2. Set for CW sweep at 8 GHz.

3. Set the sweep time to 5 seconds.

4. Set the power to -8 dBm.

ALC level for Port 1 (Procedure Q)

1. Prepare the PNA and Power Sensor as described above.

2. Connect PNA Port 2 to SRC 1 IN.

3. Connect the power sensor to Port 1 RF OUT.

4. Issue the Test Set I/O commands: 32,0 and 0,1 (ALC on and Port 1 RF
OUT).

5. Identify the “Port 1 & 2 ALC Amp”, see Figure 2-10 on page 58. Identity R7
and R3, see Figure 2-20 on page 84.

6. Adjust R7: turn full CW (may require up to 30 turns) then 5 turns CCW.

7. Adjust R3: adjust for a reading on the power meter of 12.5 dB (± 0.1 dBm).

ALC level for Port 3 (Procedure R)

1. Prepare the PNA and Power Sensor as described above.

2. Connect PNA Port 2 to SRC 2 IN.

3. Connect the power sensor to Port 3 RF OUT.

4. Issue the Test Set I/O commands: 32,0 and 0,16 (ALC on and Port 3 RF 
OUT).

5. Identify the “Port 3 & 4 Mod/Amp,” R7 and R3, see Figure 2-10 and Figure
2-20.

6. Adjust R7: turn full CW (may require up to 30 turns) then 5 turns CCW.

7. Adjust R3: adjust for a reading on the power meter of 12.5 dB (± 0.1 
dBm). 
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ALC level for LO (Procedure S)

1. Prepare the PNA and Power Sensor as described on page 84.

2. Connect PNA Port 2 to LO IN on the rear panel of the test set.

3. Connect the power sensor to Port 1 LO OUT.

4. Identify the “LO Mod/Amp,” R7 and R3, see Figure 2-10 and Figure 2-20.

5. Adjust R7: turn full CW (may require up to 30 turns) then 5 turns CCW.

6. Adjust R3: adjust for a reading on the power meter of 12 dB (± 0.1 dBm). 

Figure 2-20 

MUX RF Connections (Procedure Z)

Refer to Figure 2-2 on page 52 and Figure 2-10 on page 58 for the location 
of the Interface Board, SMB connectors and IF cable routing information. 

The SMB connectors on the cables that connect to the Interface Board 
(N5261-60101) sometimes become loose after multiple connections. A loose 
connector may allow crosstalk between IF signals and may cause higher than 
expected noise floors. After installing an Interface Board, check for loose 
connectors on all thirteen SMB connectors (J303, J250, J302, J200, J301, 
J150, J300, J100, J251, J201, J151, J101, J304). 

If there is a loose connection, replace the cable. The N5262A front panel cables 
part number are 8121-0150, rear panel cables are part number 8120-8483.

Mod Amp Adjustments

R7R3
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Safety and Information 

Introduction

Review this product and related documentation to familiarize yourself with 
safety markings and instructions before you operate the instrument. 

This product has been designed and tested in accordance with accepted 
industry standards, and has been supplied in a safe condition. The 
documentation contains information and warnings that must be followed by 
the user to ensure safe operation and to maintain the product in a safe 
condition.

Safety Earth Ground

This is a Safety Class I Product (provided with a protective earthing 
ground incorporated in the power cord). The mains plug shall only be 
inserted in a socket outlet provided with a protective earth contact. 
Any interruption of the protective conductor inside or outside of the 
product is likely to make the product dangerous. Intentional 
interruption is prohibited.

Always use the three prong AC power cord supplied with this product. Failure 
to ensure adequate earth grounding by not using this cord may cause 
product damage and the risk of electrical shock.

Declaration of Conformity

Declarations of Conformity for this product and for other Keysight products may 
be downloaded from the Keysight Regulatory Website. Click on 
"Declarations of Conformity" and enter your product number to find the latest 
Declaration of Conformity statement. http://regulations.about.keysight.com

Statement of Compliance

This instrument has been designed and tested in accordance with CAN/CSA 
22.2 No. 61010-1-04, UL Std No. 61010-1 (2nd Edition).
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Before Applying Power

Verify that the premises electrical supply is within the range of the instrument. 
The instrument has an autoranging power supply.

If this product is not used as specified, the protection provided by the 
equipment could be impaired. This product must be used in a normal 
condition (in which all means for protection are intact) only.

The Mains wiring and connectors shall be compatible with the connector 
used in the premise electrical system. Failure, to ensure adequate earth 
grounding by not using the correct components may cause product damage, 
and serious injury.

Always use the three prong AC power cord supplied with this product. Failure 
to ensure adequate earth grounding by not using this cord may cause 
product damage and the risk of electrical shock.

This product is designed for use in Installation Category II and Pollution 
Degree.

Before switching on this instrument, make sure the supply voltage is in the 
specified range.

Verify that the premise electrical voltage supply is within the range specified 
on the instrument.

Ventilation Requirements: When installing the instrument in a cabinet, the 
convection into and out of the instrument must not be restricted. The ambient 
temperature (outside the cabinet) must be less than the maximum operating 
temperature of the instrument by 4 °C for every 100 watts dissipated in the 
cabinet. If the total power dissipated in the cabinet is greater than 800 watts, 
forced convection must be used.
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Danger of explosion if battery is incorrectly replaced. Replace only with 
the same or equivalent type recommended. Discard used batteries 
according to manufacturer’s instructions.

For continued protection against fire hazard replace line fuse only with 
same type and rating. The use of other fuses or material is prohibited.

These servicing instructions are for use by qualified personnel only. To 
avoid electrical shock, do not perform any servicing unless you are 
qualified to do so.

The opening of covers or removal of parts is likely to expose the user to 
dangerous voltages. Disconnect the instrument from all voltage 
sources before opening.

No operator serviceable parts inside. Refer servicing to qualified 
personnel. To prevent electrical shock, do not remove covers.

The detachable power cord is the instrument disconnecting device. It 
disconnects the mains circuits from the mains supply before other 
parts of the instrument. The front panel switch is only a standby switch 
and is not a LINE switch (disconnecting device).

Connector Care and Cleaning Precautions

Remove the power cord to the instrument. To clean the connectors use alcohol 
in a well ventilated area. Allow all residual alcohol moisture to evaporate, and 
fumes to dissipate prior to energizing the instrument. 
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To prevent electrical shock, disconnect the Keysight N5261A or 
N5262A from mains electrical supply before cleaning. Use a dry cloth 
or one slightly dampened with water to clean the external case parts. 
Do not attempt to clean internally.

If flammable cleaning materials are used, the material shall not be 
stored, or left open in the area of the equipment. Adequate ventilation 
shall be assured to prevent the combustion of fumes, or vapors.



-

Regulatory Information
This section contains information that is required by various government regulatory 
agencies.

Instrument Markings
The instruction documentation symbol. The product is marked with this symbol when it is 
necessary for the user to refer to the instructions in the documentation.

The AC symbol indicates the required nature of the line module input power.

This symbol indicates separate collection for electrical and electronic equipment, mandated 
under EU law as of August 13, 2005. All electric and electronic equipment are required to be 
separated from normal waste for disposal (Reference WEEE Directive, 2002/96/EC).   

This symbol indicates that the power line switch is ON.

This symbol indicates that the power line switch is in the STANDBY position.

This symbol indicates that the power line switch is in the OFF position.

This symbol is used to identify a terminal which is internally connected to the product frame 
or chassis.

The CE mark is a registered trademark of the European Community. (If accompanied by a 
year, it is when the design was proven.)

The CSA mark is a registered trademark of the CSA International. 

This mark designates the product is an Industrial Scientific and Medical Group 1 Class A 
product (reference CISPR 11, Clause 5)

This is a marking to indicate product compliance with the Canadian Interference-Causing 
Equipment Standard (ICES-001).

Direct Current.

IP 2 0 The instrument has been designed to meet the requirements of IP 2 0 for egress and 
operational environment.

The RCM mark is a registered trademark of the Australian Communications and Media 
Authority

Indicates the time period during which no hazardous or toxic substance elements are 
expected to leak or deteriorate during normal use. Forty years is the expected useful life of 
the product. 

This symbol on all primary and secondary packaging indicates compliance to China 
standard GB 18455-2001.

South Korean Certification (KC) mark; includes the marking's identifier code which follows 
the format: MSIP-REM-YYY-ZZZZZZZZZZZZZZ.

ICES/NMB-001 
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Battery Collection

Do not throw batteries away but collect as small chemical waste, or in 
accordance with your country’s requirements. You may return the battery to 
Keysight Technologies for disposal. Refer to “Contacting Keysight” on page 92 
for assistance.

Electrical Safety Compliance

SAFETY

Complies with European Low Voltage Directive 2014/35/EU

— IEC/EN 61010-1:2010, 3rd Edition 

— Canada: CSA C22.2 No. 61010-1-12

— USA: UL std no. 61010-1, 3rd Edition 

— Acoustic statement (European Machinery Directive 2022/42/EC, 1.7.4.2U)
Accoustical noise emission
LpA<70 dB 
Operator position
Normal operation mode
Per ISO 7779

EMI and EMC Compliance

EMC

Complies with European EMC Directive 2014/30/EU

— IIEC 61326-1:2012/EN 61326-1:2013

— CISPR Pub 11 Group 1, class A

— AS/NZS CISPR 11:2011

— ICES/NMB-001
This ISM device complies with Canadian ICES-001.
Cet appareil ISM est conforme a la norme NMB du Canada.

— South Korean Class A EMC declaration: This equipment is Class A suitable 
for professional use and is for use in electromagnetic environments outside 
of the home.

A 급 기기 ( 업무용 방송통신기자재 ) 이 기기는 업무용 (A 급 ) 전자파적합기

기로서 판 매자 또는 사용자는 이 점을 주 의하시기 바라 며 , 가정외의 지역

에서 사용하는 것을 목적으 로 합니다 .
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Electrostatic Discharge Protection
Electrostatic discharge (ESD) can damage or destroy electronic components. 
The product is shipped in materials that prevent damage from static, and 
should only be removed from the packaging in an anti-static area ensuring that 
the correct anti-static precautions are taken. 

Two types of ESD protection are listed below. Purchase acceptable ESD 
accessories from your local supplier.

— Conductive table-mat and wrist-strap combination

— Conductive floor-mat and heal-strap combination

Both types, when used together, provide a significant level of ESD protection. 
To ensure user safety, static-safe accessories must provide at least 1 MΩ of 
isolation from ground. 

These techniques for a static-safe work station should not be used 
when working on circuitry with a voltage potential greater than 500 
volts.
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Keysight Support, Services, and Assistance

Service and Support Options

There are many other repair and calibration options available from the Keysight 
Technologies support organization. These options cover a range of service 
agreements with varying response times. Contact Keysight for additional 
information on available service agreements for this product. 

Contacting Keysight

Assistance with test and measurement needs, and information on finding a 
local Keysight office are available on the Internet at:
http://www.keysight.com/find/assist

You can also purchase accessories or documentation items on the Internet at: 
http://www.keysight.com/find

If you do not have access to the Internet, contact your field engineer.

In any correspondence or telephone conversation, refer to the Keysight 
product by its model number and full serial number. With this information, 
the Keysight representative can determine the warranty status of your unit.

Shipping Your Product to Keysight for Service or Repair

IMPORTANT Keysight Technologies reserves the right to reformat or replace the internal 
hard disk drive in your analyzer as part of its repair. This will erase all user 
information stored on the hard disk. It is imperative, therefore, that you make 
a backup copy of your critical test data located on the analyzer’s hard disk 
before shipping it to Keysight for repair.

If you wish to send your instrument to Keysight Technologies for service or 
repair:

— Include a complete description of the service requested or of the failure and 
a description of any failed test and any error message.

— Remove and retain the front handles and all rack mount hardware. The 
analyzer should be sent to Keysight in the same configuration as it was 
originally shipped.

— Remove and retain the front handles and all rack mount hardware. The 
analyzer should be sent to Keysight in the same configuration as it was 
originally shipped.

— Contact Keysight for instructions on where to ship your analyzer.
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